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models and editing the contrast in your holiday snaps can get repetitive. 

Photoshop, 3ds Max and ZBrush can be used for so much more. You can 

bring your art to life. From using digital painting techniques to create new 
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using the software available to you. Utilise concept art to produce your own 

mechs and monsters, design your own charismatic characters and create 

original landscapes and architecture for your fantasy world. 

Also included with the book is a collection of free to download Photoshop 
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Build your 
own dystopia 
concept 
Use digital painting techniques to create a photoreal 

Learn how to use Photoshop to 

create photoreal concept art with 

this tutorial. You will be using a ‘photo 

digital paint – to create a base to paint over. At 

points to create an interesting concept that 

tells a story. Creating a realistic painting in a 

tutorial will explain how to use this for your own 

projects and push your Photoshop skills to a 

The Last of Us 

out what they’re capable of doing.

10  Fantasy Art Genius Guide

Concept
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Tony Andreas 
Rudolph
www.zulusplitter.de

Artist

Rudolph is a concept 
artist and digital matte 
painter working in the 

has worked on projects 
like Guardians of the 
Galaxy, Jupiter 
Ascending and Captain 
America 2.

Photoshop

Source Files

Software

needed for the tutorial, 
from the base image to 
all the added photos.

Concept
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Prepare the background
Composite multiple images to create a base

Open the plate  First, open the plate image that will be the base for your 

concept. You can use the same one that was chosen for this image, which 

can be found on the disc (‘IMG_3383.jpg’). Start analysing the image to ensure that 

anything you add follows the same colour grading and light direction. The image has 

very diffused lighting, which means no directional light and no shadows. It has more or 

less only ambient occlusion and contact shadows created by the objects in the scene.

Add the basic background  Download ‘IMG_0391.

jpg’ and ‘IMG_0401.jpg’ from the disc. These will be added 

on the left and right of the image. Make sure that the images 

have the same diffused lighting situation as the plate. Import 

the images by moving them into the scene with the Move tool. 

Match the perspective of the image on the left slightly more using 

the Cmd/Ctrl+T shortcut for the Free Transform tool. After that, 

create a ‘Checks’ group with a Hue/Saturation adjustment on 85% 

Saturation. The check layers will help to match the colours better.

The ‘photo bashing’ technique 
concept and start with photo bashing. This technique helps to create fast, good-looking 

elements for the concept. But often these will not match the image 100 per cent. This is why you 

will need to paint over them later. For now, add the tyres (‘IMG_9304 .jpg’) and grassy elements 

on the left by using the Lasso tool to select the parts from the source references and the Move 

tool to move them into place.

Prepare the plate The next step is a small but important step 

to save time in the future. Start to prepare the image by separating the 

foreground from the background. You will use the building in front of the tree 

for the cut. Create a new group. Now start using the Polygonal Lasso tool and 

create a selection on the edge of the station. When you have done this, click 

on the mask icon in the Layers panel to create a mask on the group. 

01

03

04

02

“Analyse the image to ensure that 
anything you add follows the same 
colour grading and light direction”
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Station destruction  The next step is to add 

more interesting elements. Start to destroy the roof 

of the station by selecting one side of it using the Selection 

tool. When it’s selected, press Cmd/Ctrl+Shift+C and 

then Cmd/Ctrl+V. Photoshop will create a new layer 

containing that section. Then do the same with the other 

side. After that, press Cmd/Ctrl+T for the Free Transform 

tool, hit the Cmd/Ctrl button and move down the roof 

building material and move it under the sides.

 Add more 

details to the collapsed area using the same 

techniques as before. Don’t forget to use layer masks 

and paint the masks by hand with the Brush tool and not 

the Eraser to have more control. To match the colours 

quickly, go to the collapsed building and grass layers. 

Every element or layer has to be matched separately. 

Then go to Image>Adjustments>Match Color and set 

to keep a bit of the original colour intact.

Add trees  When you have done this, 

open one of the tree images on the disc 

(‘DSC_0218’). To extract the tree from the sky, go to the 

Channels tab and look for the channel with the most 

white and black contrast between the tree and sky. 

Duplicate the channel by moving the channel to the 

New Layer icon on the bottom. Then go to Image> 

Adjustments>Curves and move the bottom and top 

anchor points to around the middle. Then click on the 

channel, click on the RGB channel, duplicate the layer 

and move it onto the canvas.

bashing of the foreground. Go to Image>Image Rotation>Flip Image Horizontal. This will help to 

give you a fresh look at the image and pick out any mistakes. Create a rule of thirds raster to plan the next 

steps. Go to Image>Canvas Size, move the top anchor point to the middle and enter 2947 as the Height. 

Only shrink down the bottom part of the image. Then create a new group over the background group and 

use the same mask.

 Repeat the previous method on another tree for the scene. Now create 

a new group. Hit the Opt/Alt key on the mask of the background group and then hit the mask icon 

to add the same mask to the trees group. Move the trees to the position you want with the Move tool. After 

that, create a Levels adjustment by clicking the circle icon. In Levels, push the blacks a bit more up over the 

Output Levels area. Do the same with the background group to lighten up the industrial images.

05

06

08

07

09

To better integrate all elements, create a master copy by hitting Cmd/Ctrl+A, then Cmd/
Ctrl+Shift+C and create a copy of the whole image by hitting Cmd/Ctrl+V. Then go to 
Filter>Blur>Gaussian Blur and blur by 5 pixels. Set the layer to Lighten blending mode at 
around 15%.

Integrate elements in your work
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Perfect the scene
Add in details for a balanced composition

Paint the masks  The next step is to add 

in a tree to the front area between the railway 

station elements to make it a bit more integrated. Use 

the previous tree image you used for the background 

tree and move it into the position you want. You now 

need to go to Image>Adjustments>Match Color 

and match the tree colour with the grass at the front. 

You can then create a mask on the tree and paint the 

mask with a round black brush. 

Paint the fog The background has too 

many small and tiny details. You need to push 

back everything with fog. Create a new layer in the 

Overpaint group and over the Trees group for the 

foreground. Then use the Brush tool and a cloud 

brush or a round brush with 0% Hardness. When you 

start painting, add more fog to the parts that are in 

the centre of the image and less on the right part for 

a transition.

Start painting  Next, create a new layer 

in the group. Choose the Brush tool and use a 

textured brush like the chalk brush. Pick some of the 

darker colours in the background and start to paint 

over it. Make sure that your brush strokes follow the 

shape of the building part or perspective. If you want 

to destroy a part of the building, pick a dark colour 

around it and paint back the lighter elements like the 

walls. Use a custom cloud brush for the smoke.

Paint the foreground  Create a new 

layer. This is what you will paint the new details 

on. Paint the masks for the photo-bashed elements 

as well to integrate them more into the concept. On 

the Overpaint layer, start painting the roof collapse 

and deleting the highlights from the tyre with a chalk 

brush. Then create a new layer for the plants. Use 

the Mixer Brush tool with ‘Dry, Heavy Load’ and 

‘Sample All Layers’ selected. Choose a plant brush 

and pick the colour information from the tree from the 

foreground you added before and start painting.

Final photo bash  Now you are done 

with all the elements and image information 

you need for the overpainting stage. Don’t worry 

about the edges of some lighting directions that 

don’t match 100 per cent with the base plate. You 

only need the information from the references to 

create a faster and more realistic result. Create a 

new group over the background group and under 

the background trees group with the same mask. 

Call it ‘Overpaint’.

Storytelling elements The whole 

concept needs more storytelling elements as 

well as moving objects. You need to paint this in on a 

new layer just with black. Use a simple round brush to 

scribble these elements on very quickly and roughly. 

Create separate layers for each element, which 

means in the background Overpaint group and in the 

foreground Overpaint group. These two new elements 

will be your composition focal points too.

10

13

12

15

11

14

Adding noise and a kind of chromatic aberration helps to sell a concept and turn a digitally 
created image or painting into something more like a photograph. To add noise, create a 
grey layer and set it to Overlay mode, then go to Filters>Noise>Add Noise set to 400% and 
Uniform and bring down the Opacity to 15%.

Add noise for effect
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 The collapsed part 

of the railway station has too many black, small 

parts. You need to integrate the collapse more into the plate. 

Start painting on top of it on the Overpaint layer from before 

and pick a colour from a collapsed building reference. To 

paint the stuff, use a chalk brush with the texture to create a 

used look and less painterly feel. Pick as much as you can 

from the reference to create more colour differences. Work 

backwards if the result is a monochromatic painting.

 Create a new fog 

layer over every layer. Choose 

a cloud brush and pick the sky to add 

more fog to the foreground as well 

as on the left side to push the details 

away. Just keep the roof fog-free. 

Then use a reference image for the 

girl and start painting on top of it to 

match the lighting direction. Paint the 

girl’s bag by hand using the Brush 

tool and the Polygonal Lasso tool to 

get sharp edges. Finally, paint the 

destruction on the roof on the right 

side as well as the sun rays.

 Open a 

rusted metal texture and move it into the PSD over 

the Overpaint layer. Make it with Cmd/Ctrl+Shift+U grey, set 

it to Overlay and move it over the painted roof from the step 

before. Then go to the vegetation layer and paint again with 

the Mixer Brush tool to create more plants on the left side 

as well as on the rails. Pick on different areas on the tree to 

create randomness. Then use the normal Brush tool with a 

plant brush and paint plants on the roof on the right side on 

the same layer.

 The last element is the jet in the 

background. Use the same techniques as before to 

paint and design an interesting jet. Make sure the exhaust 

trail and the headlights are a warmer colour than the 

background element. After this, make a master copy and 

add noise to the image via Filter>Noise>Add Noise on 

around 8%. Then copy this layer and sharpen it a bit with the 

layer. Go to the Yellow and Red channel and move the 

colour to the right to get greener plants.

 The image is done. You should have three focal points: 

the jet, the collapsed roof and the girl. The jet is a warmer colour than the background. The 

collapsed roof has the most details and no fog, and the girl is the darkest point in front of a bright 

background. You also have a simple one-point perspective that is leading to the girl. The girl leads 

to the jet and the roof. If you look at the roof this is leading to the jet and the jet back to the roof. These 

16

18

17

19 20

“Use a chalk brush with the texture to create a used 
look and less painterly feel”



16  Fantasy Art Genius Guide

Concept

In this tutorial, I am going to show you how to quickly 

model a large-scale fantasy ship. 

16  Fantasy Art Genius Guide

Design your own 
fantasy vehicleStefano Tsai

Artist

Source Files

Software

Concept
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Concept
This craft is a kind of Chinese-style battleship, with the 
wings, cannons and sails based on Chinese temples. 
I imagined that there would be steam engines inside.
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Create your sections
Clearly defi ne the different parts of your ships

Split off the ship’s 

main hull and think like 

an engineer – how can 

we build this ship? If you 

think of building the ship 

as one big project then 

it’ll end up seeming like 

a lot of work and it’ll be 

changes. We should 

keep it as simple as 

possible. Section off 

different parts of the ship 

into different groups and 

– as you can see from 

the image – models with 

the same colour are 

instanced, so you have 

full power to change 

them with minimum 

effort. Don’t build the 

whole ship in one go, 

but build the parts 

separately.

 Add the secondary blocking details on the hull and apply different colours to help differentiate each group. In my project, 

I added the main bridges, master poles, extended the structure and added cannons. To make the process simpler, reuse assets as much as you can. For 

example, the purple blocks in the image are all the same asset. Extend the secondary blocking on the main hull and like before, reuse the same models as much 

as possible.

01

02
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Include wings For our fantasy ship, there is no way 

that it would work without wings. It is the element that really 

makes this stand out as fantasy. Don’t make them too big or too 

realistic, but try to keep them looking quite fantastical. Be careful 

not to make them too large, otherwise they will dominate the ship 

and cover the main hull, which will ruin the overall effect (unless 

you’re designing a fast vessel). Switch into Clay mode to see the 

ship in one solid colour, as this way we can see the entire model 

clearly without obstructions.

03

04

05

To save time and speed up progress, remember that you can take elements that 
you have already used and place them in other parts of the ship. You can simply 
resize or reshape them and they’ll feel completely new . For instance, the middle 
section of the hull was repeated and re-used most as its structure can be easily 
extended to other parts of the ship. For the interior of the ship, cannons, steam 
engines, platforms and so on can all be easily copied and placed around where 
you feel they make most sense.

Learn to recycle and reuse 
elements of your work

Build wooden structural frames To make things 

more believable and to have something to show later on 

when we open up the panels, let’s build up a structure inside the 

middle section of the hull’s blocking. We need to consider where 

exactly the decks are going to be and where we’re going to place 

the windows and extended platforms, so this means we need 

to leave them some space. Thinking things through like this will 

emphasise the believability of our fantasy ship.

Place the planks on the ships With the main wooden beams and posts ready, 

let’s start placing planks along them. Remember that these sections need to be tiled, 

so they can’t be overlapped – everything has be to placed inside their boundaries. We can also 

add stairs and some windows frames to bring in the sense of scale. It’s details like these that 

really emphasise the sheer size of the ship. The bigger it is, the more imposing and impressive!
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Stefano Tsai is a 
concept designer and 
3D artist. He has been 
working in the game 
and entertainment 
business since 2001, 
and is still excited by 
his work every day 
despite over a decade 
in the business

Factory production line of scout 
robots 3ds Max (2013) 

 An automatic machine for producing 
military robots. You can see how 
friendly the employees are.

Factory production line of 
enforcement vehicles 3ds 
Max (2013) 

 A comfortable and cosy production 
line in a factory, building law-
enforcement vehicles.

Car study 3ds Max (2013) 
 This was a study project for the front 

panel of a car. For the image, I tried out 
two different colour casts, which gave 
the image a different kind of tone.

Step back and check the design  It’s always advisable to check how the overall look is panning out 

throughout the process. Reveal all of the middle hulls to see how everything looks together. If it looks too straight 

and formal then the surface is continuing without a break. To add interest, take one of the upper decks, copy it and turn 

it into a duplicate version. Push it out a bit further to make an extended structure. These new platforms are good areas to 

place cannons, as they can get a better shooting angle. 

Add functional mechanisms After checking all of the connected parts, go back to complete the 

mechanical joints, including the mechanisms for both side sail wings and for the main sail wings. These need to 

be connected with the mechanical parts and should lead to the central system. In this case, the central area will be the 

ship’s keel. The keel area has plenty of equipment from the front to the end of the ship, so it’s essentially the nerve centre 

of the ship. You want to add many details to make it feel functional.

06

07

We can’t put details everywhere on the ship, as it’ll get too noisy and it’ll take too much time. 
Instead, we need to pick a few key areas. To do that, create highlight details for the chosen areas, 
and in others dial the detail back – you want the eye to naturally fall on your focal points. On my 
ship, I spent time adding details to the stern tower, the bow, the propellers and master cannons. 
These elements really emphasise the ship’s fantasy style.

Focus 
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08

09

10

Finish the rear towers For rear towers I won’t be 

creating a  semi-open structure, so there is no need to 

work on the interior parts of the ship for these elements. Instead, I 

focused mainly on the exterior details of the towers. I used images 

of Chinese temples as my reference for the shape of the towers. To 

make them feel larger and more imposing, I created an extended 

structure with parts that hang out. This way, the tower seems to get 

bigger as it gets taller, and it gave me more space to add some 

beautiful Chinese roof details. Remember that this is fantasy; while 

we want things to feel believable, they don’t always have to be 

physically accurate.

Complete the bow Generally, this is the most armoured part of the whole ship 

as it needs to be built for combat collision. For dynamics, if you want the shape to be 

stronger, you need to keep it as simple as possible. As such I didn’t got crazy with the design 

Give it power The wings and 

the propellers are the source of 

power for the ship. Obviously we can’t 

get reference for these from real ships, 

so we need to look elsewhere. The 

surface of each of the propellor blades 

needs to be huge to push the ship 

forward and to maintain a reasonable 

rotation speed – you don’t want it to spin 

makes more sense for it to move more 

subtly. Aesthetically, its size can make it 

a key element of the ship. Don’t be shy 

about making it much bigger than you 

“After checking all of 
the connected parts, 
go back to complete 
the mechanical 
joints, including the 
mechanisms for 
both side sail wings 
and the main sail”
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Work on the rear 

The rear of the ship 

is the biggest target for the 

enemy, as this is where the 

rest. Naturally it makes sense 

to have lots of heavy armour 

Make the tower appear 

Include weapons 

“Naturally it 
makes sense 
to have lots 
of heavy 
armour to 
surround it 
and to 
protect the 
high-ranking 
offi cers”

11

12
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Focus on the front bow Approach the front part of 

the ship as you did the back: it also needs to be ready for 

strong impacts. I installed a few scattered structures for pre-crash 

purposes, so that when it happens it’ll reduce the damage to the 

main hull. The same goes with armour – keep spreading the same 

style of armour protection boards around the ship. You want your 

ship to feel menacing and ready to take on whatever is thrown at it!

Materials, 
lighting and 

render This image only 

focuses on the modelling 

process in relation to the 

concept and we didn’t 

spend any time on proper 

unwrapping, textures or 

lighting. You can see a quick 

result on the left, where we 

have only applied box mapping 

and a few materials such as 

wood, metal and fabrics. I used 

V-Ray 3.0 and an image-based 

method to create a quick previs 

image. I also applied an AO 

the image, give the materials a 

slightly rough texture and make 

the colours and lights a little 

more lively. 

Check for 
overall balance 

Check the model to see if 

everything is balanced. At 

this stage, I realised that the 

main mast near the rear tower 

was too close and covered up 

almost 70 per cent of visibility, 

so I deleted it, and then added 

more details on the other 

masts to make them appear 

stronger and to make them 

easier for the crew to climb up. 

For the crew’s safety, I also 

built a few small platforms 

along each mast. I also added 

a small rudder-esque wing at 

the ship’s end to give it more 

control. Look around to see 

if everything is well balanced 

and if not, start playing with 

new ideas.

13

14

15

Once you’ve built up the basic shape of the ship, don’t be 
afraid to try out other compositions. This is just the start of 
the process and the idea is to explore your idea and to 

Try 
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You don’t have to be a master of 3D 

graphics to be able to use 3D to your 

advantage while creating 2D illustrations in 

Photoshop. In this tutorial we will look closely at the 

process of mixing different digital techniques in order to 

with different Photoshop tips and tricks, we are going to 

focus on what is most important in any kind of creative 

work; composition, lighting and the different parts of art 

theory that help us to come up with images that are full 

of atmosphere and are well-balanced in terms of visual 

thing you will need to create really professional visual 

creations, it’s always helpful to look back at classic art 

theories and mechanisms that have been used for 

Photoshop being the main program for creating visual 

software and techniques in Photoshop to create even 

Fantasy Art Genius Guide  25

Produce your 
own 3D concept
combining basic 3D renders and stock photos

Tomáš Müller
Artist

painter and retoucher, 
working for a wide variety 
of clients and studios from 
different corners of the 

Photoshop

Source Files

Software

On FileSilo, explore the 

learn how the 3D and 
photo elements were 

“Custom brushes and 
plug-ins are not the 
only thing you will 
need to create really 
professional visual 
creations, it’s always 
helpful to look back at 
classic art theories 
and mechanisms”

Start with composition
a central composition, which was picked purposefully 

the magazine title into the composition while maintaining a nice 

Every part has its place

On this image you can better see 

the main elements and their placement, 

of the bomb are placed in the ‘golden points’ 

near the horizontal and vertical thirds of the 

image, pushing the viewer’s focus away from 

at an angle, which also helps to break the 

01

02

Coming up with a balanced composition
Think about your creation and sketch before starting work 
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Let the light build the image 

Another important part of the composition is 

05

04

03

Sketch, 
sketch 

and sketch 
again

Master painting with default brushes

While sketching, 
keep everything 
simple. Once you 
have a sketch you 
like, then you can 
try to enhance 
your sketch with a 
few textures or 
photos. This will 
give you a clearer 
idea about the 

amount of detail 
you’ll include.

Keep 
it easy

“There is 
light 
decreasing 
towards the 
foreground 
and there is a 
mist created 
by the 
waterfall”
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06

07

08

09

Start with simple shapes This bomb 

shape started with just a grey circle. Shadows 

and highlights were painted on top of it with a 

default Soft Round brush. This might seem simple 

but it’s hard to create complex shapes without the 

knowledge of how to paint basic objects. Once you 

know how to paint basic geometrical objects it‘s a lot 

easier. It‘s similar to when animators are practicing 

by trying to put life into a ball bouncing. Simple often 

does not mean easy! 

Master the details Now we will look 

at using photos to add detail to an image. 

As you can see on the image, there is texture and a 

few added details. In this case we are using a stock 

photo of a naval mine. To re-create this effect just put 

the desired photo on top of your painted object, then 

switch the photo layer to Soft Light or Overlay. Then 

select Filter>Other>High Pass, on the layer with 

the photo. The amount of Radius on the High Pass 

equals the amount of detail that becomes visible. 

amount of detail and apply. 

Add colour to your sketches Keep 

It will help you to avoid unnecessary changes that 

of not having clear ideas about colours from the 

very beginning. As the image shows, even one 

Selective Color adjustment layer and one layer set 

to Overlay with a few soft green brushstrokes can 

give you at least a rough idea about your chosen 

colour scheme. 

Add some 
reality to 

your design Now 

we can take a look at 

how to enhance our 3D 

elements with additional 

details such as moss, 

dripping water, rust 

textures, leaking water 

and foliage hanging 

below the main objects. 

Always think about 

what the scene you 

are creating would 

include in real life. What 

kind of weather does the 

scene have and how it 

would affect objects in 

the scene? 

Texturing the 3D parts
Add details and additional textures to your rendered parts

The scene is 
full of water 
and humidity, 
so all metal 
parts should be 
rusty and dirty

Water should be also 
dripping from the objects, 
because water condenses on 
the surface and pours down

In forests 
near water there 
is always some 
amount of moss 
present, so it should be 
added on 3D parts as well

“Additional 
details such 
as moss, 
dripping 
water, rust 
textures, 
leaking 
water…”
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Add the downpour  Another nice detail 

to add is dripping water. In real life, water mist 

would condense on cold metal and pour down in the 

form of droplets and small streams. In order to create 

this effect you can either paint droplets and streams 

by hand or use photos of dripping water on a black 

background like we did in this case. White water, 

black background – with this setting you can just 

switch the water layer to Screen and paint the water 

itself by using the Clone Stamp wherever you need 

it to be.

Let it grow The next additional detail is moss on top of objects and grass below 

them. Grass is painted by hand with a 2-4px brush (the thickness of the brush depends 

on the resolution of the image you are creating). Moss is painted using the Clone Stamp with 

a default round brush. A stock photo of spherical moss is used to make sure that it follows the 

shape of the bomb spheres. From that point all the moss is hand painted with the Clone Stamp 

set to 50% Opacity and 50% Flow. 

Play with the tiny details Even the 

tiniest details matter, even those that are not 

small additions here and there can increase the look 

of the whole image or add small hints of backstory or 

the functionality of objects. There are small illegible 

texts and textures added in this step to make the 

viewer wonder what could happen next or what the 

story of the scene is about.

Rust it up Rust and leaking dirt is added to the image 

using stock photos and textures of real leaking and rusting 

metal. Adding textures is simple, just use different blend modes 

like Screen, Multiply and Soft Light. Depending on the brightness 

of the additional textures, bright textures are best set to Screen and 

dark stains to Multiply. Always check the shape of the object that 

you apply texture on, and make sure that the texture is following the 

shape of the object correctly. Use the Warp tool to make the texture 

follow shapes and edges.

“Always think about what 
the scene you are creating 
would include in real life”Perfect the 

10

11

12
13
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Think ahead and build up It’s always 

a good idea to proceed systematically with 

starting point which gives you the advantage of 

seeing what you need to do to add to or improve the 

image. After some time spent looking at the image 

you start to lose the ability to perceive the image 

from a distance and see things that need or don‘t 

need to be done. So think ahead before you start 

compositing. In this case, we are building our image 

from background to foreground.

Create an atmosphere Having 

created the background at the beginning 

scene conditions, such as lighting, atmosphere and 

colours. Every enviroment is affected by surrounding 

light from the sky and sun, as well as light bounced 

back to the scene from different surfaces or 

the main mood and background set, focus on 

ensuring everything else corresponds with it. Try 

obvious cut-outs.

Finish the scene Now, when we have 

all the main parts present and building up 

works already. Systematic build-up paid off! But the 

overall colour scheme is a bit monochromatic and it 

is apparent that it could be pushed further in terms 

of colour variety and mood. Let’s see how far we can 

push the image. 

Play with the lighting and effects To increase 

the realistic look of light sources in the scene, we can add 

all sorts of effects produced by light and camera lenses in real life, 

glare. As you can see on this image, the montage is switched for 

solid black colour so you can see clearly how all the light effects are 

that is generated on a black background can be added simply by 

switching its layer to Screen and adjusting for the desired opacity.

Final colouring and adjustments 

colour grading. Grading was done selectively one 

small step at a time. Don’t be afraid to use many 

adjustments layers and masks to deliver the exact 

colour and feeling you need. There is no need to 

do all of the colouring in at once, so take your time, 

adjust all objects and colour tones one by one, 

look away for a moment to gain visual distance and 

then look back at the illustration again. This allows 

you to see more clearly if the image needs more 

adjustments or not.

Use a High 

14

17 18

15 16

Finishing the scene
Build your way up to the fi nal image

“There is no need to 
do all of the 
colouring in at once, 
so take your time, 
adjust all objects and 
colour tones one by 
one, look away for a 
moment to gain 
visual distance”
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The tools in both ZBrush and 3ds Max 

are very handy, especially when it 

comes to sculpting anatomy. Over the 

next few steps we’ll discover methods in these 

programs to sculpt a heroic character.

For the creation of Beowulf, our main character, 

we will start from a base mesh, where we will focus 

on how to obtain a dynamic, heroic pose. At the 

same time as this, we will be trying to model a 

using the default sculpting brushes in ZBrush along 

with some other customised brushes in order to 

achieve different types of effects. 

Then, we will learn how to use more advanced 

techniques like ZSpheres and DynaMesh along with 

simpler ones, such as masks and Mesh Extraction, 

in the design and creation of the sea serpent. After 

that, we will begin detailing, which will help us to 

make our characters look more natural. 

We will also use Decimation Master in order to 

create a model of lower-polygonal resolution. This 

where we can add materials and illuminate the 

model how we like. Last of all, we’ll make the most 

of V-Ray for rendering, then post-process our scene 

in Photoshop.
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Sculpt dynamic forms
Portray important moments in your designs by creating a dynamic 
sculpture of your subjects

“For the creation of 
Beowulf we will start 
from a base mesh, 
where we will focus on 
how to obtain a 
dynamic, heroic pose. 
At the same time as 
this, we will be trying 
to model a masculine 
muscular anatomy”

Pre-production 
going to do it. The pre-production stage is one of the most important ones. At this point we need to look for all different kinds of references, whether that’s visual, 

textual or of any other kind, as these will help us form our main idea. In this particular case, I used references from different sources: the epic poem ‘Beowulf’, the 2007 

Think about 
composition With 

all the information at hand, it’s 

time to think about the best 

way to show our piece. For 

this, it is necessary to begin 

sketching what we have in 

mind, whether that means 

drawing it or by doing it in 

sure that you have a rough 

draft so it does not consume 

too much time. This will give 

us the chance to play with 

shapes, poses and elements 

of our scene.

Understand the character 

It’s time to be more meticulous 

with our work. In this case, Beowulf is the 

most important element. For that reason, 

we want him to adopt not only a heroic 

pose, but also a natural and realistic one. 

Therefore, it needs to be a pose that a 

human being can perform. For hands-on 

reference, I chose to act as if I were the 

character. Obviously the character and I 

are different, but this helped me see how 

the pose works.

Besides taking 
photographs for 
general pose 
references, we can 
also take pictures for 
details, as we won’t 

that we will need 
online. For example, in 
the case of this piece, 
I took many pictures 
of my hands and feet 
to study the reaction 
of the skin, tendons 

adopted positions 
similar to those used in 

clothing references, as 
it means that we can 
see how creases work 
with different fabrics 
and surfaces.

Take 
pictures 
for 
reference

Think about it first
Create a clear picture in your mind

01

02

03
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www.danielbel.
com

Artist

Daniel has been in 
the industry for a 
decade having worked 
as an animator for 
Gameloft and currently 
as an art director for 
Waypoint Studios.

ZBrush, 3ds Max, V-Ray, 
Photoshop

Source Files

Software

the tutorial screenshots 

complete this tutorial.
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04

05

06

Use Mannequins A tool that isn’t 

very widely used by the majority in ZBrush 

is the Mannequin function. This tool consists of a 

character created from ZSpheres, which will enable 

us to pose our character in a simple, practical and 

fast way, simply by using the Rotation tool and 

In this case, I copied the pose from the previous 

reference photographs. I was then able to correct 

or exaggerate certain elements that I thought were 

appropriate for the character.

Create the muscles 

take into account in order to start 

working with muscles is to mark 

certain bony protrusions, called 

bony landmarks, that will work as 

guidelines to sculpt every muscle. 

Tubes brush to sculpt each of the 

muscles, taking into account its 

shapes and volumes according to 

the pose of the character’s limbs. 

To do this properly, we need to 

use as many anatomy references 

as possible. It is very important 

to know what our body is like and 

how our muscles work, particularly 

when putting a character in such 

an extreme pose. 

Use a base 
mesh With the 

next step is to import a 

base mesh that has been 

previously created as a 

new SubTool into ZBrush. 

This is a base mesh that I 

tend to use for characters 

with heroic proportions 

(eight-heads tall). We need 

to place the base mesh on 

the Mannequin, and using 

the Transpose tool, try to 

match it to the pose of the 

Mannequin. Once we’ve 

done this, we’ll have the main 

character mesh that can be 

subdivided in order to start 

keep working.

“This tool consists of a 
character created from 
ZSpheres, which will enable 
us to pose our character in a 
simple, practical and fast 
way, simply by using the 
Rotation tool”
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Design the monster 
This is the most creative 

and free stage of the modelling 

process. Use ZSpheres to start 

creating the body of the serpent, 

as it is a practical and dynamic 

way to obtain a cylindrical and 

continuous shape. After acquiring 

the basic shape, press the A key 

to convert it to Adaptive Skin, 

then convert it to DynaMesh to 

start playing with the shapes of 

the head and other details. In my 

project I wanted it to look like a sea 

serpent, so I masked all of its back 

the SubTool panel with the Mesh 

Extract. I did the same for its belly.

Extract 
and create 

accessories One of 

the many advantages of 

working in ZBrush is the Mesh 

Extraction feature. Simply 

by masking any part of our 

model and then clicking on 

Extract, we can generate 

a new tool of the masked 

portion within the SubTool 

panel, meaning we can get 

all kinds of basic shapes and 

use them as accessories. In 

the case of Beowulf, I used 

this feature to create his 

beard, hair, headband and 

shorts. As I have already 

explained, I also created 

some parts of the monster 

in the same way. I also used 

the Insert Mesh brush for the 

fangs, among other things. 

It’s these kinds of details that 

will bring your character to life.

Make the sword For 

the creation of hard-surface 

objects, I usually combine 3ds 

Max and ZBrush. For the sword, I 

created the entire base in polygons, 

working with subdivisions in 3ds 

Max. As a blueprint for these, 

I used an image of the original 

sword used in the Beowulf movie. 

I then modelled a base mesh and 

exported it to ZBrush, where I used 

DynaMesh to join certain parts of 

the handle, and the retopology 

function with ZRemesher to achieve 

a cleaner geometry. Like before, 

image more realistic, so I added 

scratches to the blade.



Concept
In this diorama I 
wanted to depict the 
strength, bravery, 
heroism and anatomy 
of a great character 
such as Beowulf.

Concept
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 This last 

stage of modelling is when 

we must keep an eye for 

detail in order to take our 

quality possible. As always, 

use reference images 

and your imagination to 

to really emphasise the 

reality of your work. For 

the skin wrinkles, I usually 

use the Dam_Standard 

brush together with the 

the Standard brush with 

the Stroke set to Spray in 

combination with Alpha 

40. Then smooth it with the 

Smooth Peaks brush for 

porous and rough surfaces.

 Before exporting the scene to 

any hidden or unnecessary items. It is also useful to try to group them so as 

each of them with just a part of the sword, we can group them in a single 

choose the option that suits us depending on the order of our SubTools.

 In the case of 

Beowulf, I knew my only intention 

was to export the scene to 3ds 

of it. I decided that instead of 

retopologising each element and 

would use the Decimation Master 

function in order to get a reduced 

number of polygons that 3ds Max 

could import for a later render. For 

this, go to the Zplugin menu>

Decimation Master>Pre-process 

All. This will pre-compute each 

element of the scene. Next, 

press Decimate Current, testing 

to see what the correct 

each SubTool.

10

11

12

From my own personal experience, this series of steps for 
the creation of Beowulf is the most convenient way to do it. 
However, it is not the only method you can use. I 

for your creativity, so don’t waste it!

Find
for you
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Export and import Once all our SubTools are organised and 

decimated, use the GoZ All function (which is within the Tool panel) to 

export all of the SubTools simultaneously. This tool exports from ZBrush and 

automatically opens 3ds Max, importing all objects into a new scene. Once 

the scene in 3ds Max has the full model ready, use V-Ray’s Mesh Export 

Viewport. The proxies load just at render time.

Set up the lights This process and the following one are as 

important as all the previous steps, since through these we will 

really emphasise and bring to life all of the modelling that we’ve already 

done. Therefore, it is advisable to have some inspirational images to hand 

VRayLights scattered around the scene along with HDR images. Test each 

light separately to see how each of them affects the model before creating 

Another method used to transfer all the details of a 
SubTool with millions of polygons is the using 
ZRemesher and the Project function. To do this, we 
have to duplicate our current SubTool and apply a 
ZRemesher to it, setting the parameters for a suitable 
topology. Then, from Geometry, subdivide the 
geometry as many times as necessary. Last, go to the 
Project menu of the SubTool panel and click on Project 
All. We will then get a tool with several subdivisions 
and all the details of the original piece. We can then 
extract the Displacement or Normal maps to export 
them along with the low-res version of the model.

Retopologise with 
ZRemesher
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16

17

“For every camera that we create, 
feel free to move around some 
(or all) of the lights in the scenes 
until you manage to generate the 
desired effects”

From my point of view, comments and constructive 
criticism on your work are one of the best ways for 
you to understand whether what you’re doing is 
working or not. Beyond our taste and personal style, 
we must realise that other people’s opinions are 
very important as well, whether they are a viewer or 
industry outsider’s, or a more experienced 
colleague’s insight. We need to learn how to take 
criticism in a positive and productive way in order to 
develop our work and grow as professionals.

Get feedback

Cameras and render Finding the perfect angle 

where we can show both a correct composition while at the 

same time presenting the drama of our piece is not an easy task. 

As Beowulf is no exception to this rule, place several cameras in 

order to make some test renders. For every camera that we create, 

feel free to move around some (or all) of the lights in the scenes 

until you manage to generate the desired effects on each shot – 

not every light is going to look effective in each render. V-Ray is the 

render engine that I generally choose for all my works.

Create the shader We’ll use just one material for Beowulf. The idea is to create a look 

similar to a polished stone with some sparkles and some dirt diffused on it. The point of 

that and playing around with the lights can we get this effect for the project.

Final composition When it comes to post-

processing the image, it’s best to use Photoshop for stills. 

Here, compose the original render, stressing particular areas 

kinds of blending modes. In my scene, I decided to make the 

background entirely black with a free stock image of smoke to 

add a sense of drama. Last of all, I applied some stone textures 

worth doing some colour corrections and adjusting the contrast 

tool to emphasise areas, creating points of interest.
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In this tutorial we will go through the steps to create a posed 

and detailed creature. Starting with only a sphere we will create the 

rough form of the creature and use ZSpheres to add limbs. We will 

also make use of readily available Insert Multi Mesh brushes to add features 

to the creature. After posing the creature we will use Polypainting to create 

basic materials and textures on the model. Finally, the 3D renders will be 

textures. We will also cover how to export and render the model in KeyShot 

from ZBrush 4R7.
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Awaken a beast 
with ZBrush
Model, pose and texture a monstrous creature’s life 
cycle and its natural setting

Concept
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Concept
The aim of this project is to create a 
detailed and expressive creature and its 
natural habitat.

James Suret
www.artstation.
com/artist/zerojs

Artist

ZBrush, KeyShot, 
Photoshop

Source Files

Software

the tutorial screenshots 
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creature artwork.
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Start with rough designs
Don’t worry about the fi ner details to start with

Sculpt the initial details The next step is to add character and realism to the model by sculpting basic skin 

folds and muscle structure. Using the ClayTubes and Smooth brushes we can quickly create the look of skin folds 

or wrinkles. The Dam_Standard brush is great for carving lines and wrinkles as well as carving out the mouth and nostrils. 

During this stage you may need to use DynaMesh again to smooth the mesh out. Next, add the eyes by inserting spheres. 

Then mirror the spheres using the SubTool Master plugin and move the eyes into place with the Transform tools.

Create a rough bust First insert a 

new sphere. Press T to edit the object and 

click Make Polymesh3D, also activate Symmetry by 

pressing X. Now with the Move brush set to a large 

size (by pressing the ] key), push the shape around. 

The idea is to quickly explore your ideas without 

worrying too much about what the details will be. At 

this point it’s sometimes useful to look at reference 

images of the anatomy of real animals or insects.

Develop the model using 
DynaMesh Now we have a very rough form 

of its topology. We need to use the DynaMesh feature 

to even out the surface of the model. We can then 

continue to pull out the basic form of the creature. 

When it feels like the polygons are stopping you from 

adding more detail, just use the DynaMesh feature 

again but with a higher resolution. At this point the 

polygon count is quite high and we can start using 

the Clay brush to carve in smaller features such as the 

eye sockets and skin folds.

01

02

03

When you start a new 
character you may not be 
sure how the entire character 
will look. It’s a good idea to 
concentrate on sculpting a 
bust, as this helps you 
develop your character. You 
can always create the rest of 
the character from ZSpheres 
or Insert Meshes and merge 
it with DynaMesh. In ZBrush 
4R7, when you use 
DynaMesh on a SubTool with 
multiple objects merged, it 
preserves the individual 
objects’ Polygroups.

Choosing 
a full body 
or bust
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Create the arms with ZSpheres 

To create the forearm we will start by 

inserting a ZSphere into the model. Press Q 

and you can draw out a new ZSphere and after 

pressing W you can drag the new sphere out 

repeating this process you can create the basic 

form of the arm, the Scale and Rotate tools can 

also be used. When you are happy with the arm 

click on Make Adaptive Skin under the Adaptive 

Skin menu. This new SubTool can then be added 

to the main SubTool, it’s usually best to run 

DynaMesh before sculpting further.

04

05

07

06Develop the anatomy Now we have a sculptable arm we can mirror 

the SubTool using SubTool Master menu under Plugins, if you choose the 

option to Merge into one SubTool you can then press X to enable symmetry on 

the arms. Then using the Move and Clay brushes you can build up the anatomy 

of the arm; consider where the joints will protrude and skin folds might hang from. 

To complete the creature we can now add a new sphere and pull out the basic 

shape of the lower half of the creature’s body and tail. Now use DynaMesh to 

prepare the SubTool for sculpting.

Use Insert Multi Mesh brushes Now that one set of arms is 

sculpted you can add more by clicking Duplicate in the SubTool menu. 

The new arms can then be resized and moved by making use of the Transpose 

tools. To speed the modelling process up we can add some legs to the creature 

by using a premade Insert Multi Mesh brush pack available for free at badking.

com.au. Once the brush set is loaded up you can then click on the side of the 

creature’s body and drag out the size of the leg that you want it to be. Then you 

can use the Transpose tools to position it. 

Detail the face Now the large forms of the creature are complete we can focus on adding detail to the smaller areas. Using the Dam_Standard brush you 

can create more skin folds and wrinkles. It is useful at this point to use DynaMesh again at a higher resolution to enable you to sculpt these smaller details. We 

can also add in some teeth by starting with a sphere, pulling out the basic shape and then duplicating the SubTool as we did before when we were working on the arms.
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James is currently a 
games designer

Oculus
2013, ZBrush, Photoshop

 This sorceress character was 
sculpted in ZBrush, using Insert 
Multi Mesh Curve brushes to create 
the clothing.

Nova-25
2013, Photoshop

 This is a futuristic character concept. 
I sculpted this female cyborg character 
in ZBrush, using FiberMesh to create 
the hair.

Create the landscape Now we need to create a base environment for the creatures to exist in. Starting 

from a sphere again we can rough out a rocky platform with the Move and Clay brushes; use DynaMesh to 

smooth out the mesh after large changes. When the polygon count is high enough, use Alpha materials to add a 

rough surface to the model. Then load the IMM Clod brush that comes with ZBrush and insert some rocks along the 

surface. Use the Transpose tools to resize and rotate each rock as you are inserting them. You can now also duplicate 

the SubTool containing the baby creature. It can be scaled up slightly and positioned near the front of the egg with 

Transpose tools.

Create the egg and baby The egg is created by inserting a sphere and 

roughing out the shape with the Move tool. Then use DynaMesh and tweak the 

shape further. You can use Alpha materials to quickly sculpt surface details. To create the 

baby creature, make the basic skeleton from ZSpheres based on the anatomy of the original 

creature. Then move the skeleton inside the egg and position the limbs. To move the ZSphere 

model press W, hold Alt and click on the initial inserted ZSphere. After turning the model into 

an Adaptive Skin, use sculpting brushes to add detail.

Pose the creature 

Now we can pose the 

Before we do it’s a good idea to 

merge the eyes and teeth down into 

the main body SubTool so they will 

be posed together. Make sure they 

are listed underneath each other 

in the SubTool list before clicking 

MergeDown. With the body SubTool 

selected hold down Ctrl and paint a 

mask covering the head and neck. 

Turn off symmetry by pressing X, 

hold Ctrl down and click outside of 

the model to invert the mask. Press 

R and draw out a transpose line from 

the base of the neck outwards then 

drag the end of the line to rotate the 

neck. You can then use the same 

method to pose the rest of the body 

and limbs as well as the larger baby 

creature’s limbs.

08

09

10
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Make the background Now that we have the creatures and the foreground ready 

we can make a quick background for the environment. Start by pulling out a sphere with 

the Move brush into a rough rectangle. Use DynaMesh and then pull a tunnel shape out of the 

back of the model with the Move brush. Continue shaping the cave and using DynaMesh to 

help sculpt more detail. You can also use Alpha materials to quickly add some texture but don’t 

Final details Now to complete the sculpt we can add 

make the skin look more realistic. Click on the Noise button under 

the Surface menu, here you can tweak the strength and scale of 

the noise. To apply this noise to the model click OK then Apply To 

Mesh. You can then use different Alpha materials to layer hard and 

sharp textures on the skin to create the look of bumps, veins and 

scratches on the skin. A great selection of free Alpha materials 

can be found at pixologic.com/zbrush/downloadcenter/alpha. 

Alternatively you can create your own from photos by saving them 

Polypaint the base 
textures 

with a plain material by clicking MRGB 

and selecting MatCap White01 as the 

material and FillObject in the Color 

menu. Make sure ZAdd and ZSub are 

not ticked (so you don’t accidentally 

sculpt on the mesh) and tick RGB (this 

will allow you to just paint in colour). 

It is a good idea to choose an Alpha 

material to paint with to blend colours in 

a more natural way. Then, apply some 

base materials to enhance the texture’s 

shading. To do this make sure only M 

is ticked, select a material and click 

FillObject from the Color menu.

When posing organic characters you usually need to create smooth bends, for 
example, the neck or knee. When you are painting out a mask you can hold 
down the Ctrl key and lower the RGB opacity which will draw out a softer mask. 
This will create smoother, more organic bends. You can quickly blur the mask 
by using Ctrl+click several times.

Posing forms

“Use different Alpha materials to layer hard and 
sharp textures on the skin”
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Composite 
the layers in 

Photoshop After saving the 

Lighting and rendering

Polypaint

The

Add effects and textures 

14

15

17

16

Render in KeyShot
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“To create the 
strands of slime 
and saliva you 
can draw a line 
with the Line 
Tool and then 
use the Warp 
transform tool 
to make it look 
more realistic”
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Concept

This tutorial will give you insight into the 

process of taking an idea from a budding idea 

 You will 

Model and render a 
submersible drone

“[We] took today’s interest in drones and overlaid 
that with a craft that might need to be unmanned 
but accurate in application”

Model the head  
01

Model and sketch
Develop a brief of your design

46  Fantasy Art Genius Guide

Colie Wertz

effects 

has been in the 

together 

Artist

Source Files

Software

the tutorial screenshots 



Genius Guide
Fantasy Art

Fantasy Art Genius Guide  47

xxxx

Concept
I was wondering about old WWII 
designs that were never fully 
documented, or failed. There were 
plenty of interesting wartime craft and 
weapons. I took today’s interest in 
drones and overlaid that with a craft 
that might need to be unmanned but 
accurate in application, as well as a 
potentially aesthetically interesting 
design problem. The sub drone is 
that result!



Eliminate the lies with a good model  The 3D modelling stage 

takes a lot of pressure off your sketch. You can sketch cool stuff all day, 

but if they don’t work in the round, you will be chasing notions of something not 

land who can draw nearly perfect 3D images in form, well we’re not one of them! 

Your modeller of choice can get you into a more comfortable area in your design 

process. For the sub drone, we opened Maya and made a few planes. By jerking 

some points around and adjusting those proportions, we had a little plan of the 

sub. The simple shading in a modeller will allow you to move those same points 

around and establish some interest in all three dimensions, and that’s important. 

Silhouettes rule A good design will look good in plan, front and side 

elevation. As you get a feel for your primary shape and form, which for us 

was sticking to the manta silhouette, begin thinking about what can add interest 

to your silhouettes. This is where your reference library can come into play. For this 

project the barbs on a manta’s head, which gives it the ‘devil ray’ name, are pretty 

Start sketching  For the sub drone we drew a square diagonally and 

started cutting it up. So we had an inkling of what we might be going for at 

this stage. The manta shape started to show itself, and we went from there. The 

assignment was to develop a mech for a book; we allowed (and this is key) our 

sketching and that assignment to overlap. The brief, as mentioned previously, 

was bleeding and forming itself the more it was sketched. Be present for this 

that can come later on! Don’t feel handcuffed by the word ‘sketch’ either. If you 

sketch in your modeller, do it. It’s all about having a clear mode of communication 

from your head to the medium you choose. Once you sketch something, usually 

in a top view for easier 3D understanding, challenge yourself to sketch it again. 

This puts you in a ‘I’m committing’ frame of mind, and a little light goes off in your 

head that tells you that what you’re doing is carrying more worth than just a simple 

doodle. Things will change, and the idea begins to form of what we think of as a 

Concept

Develop a brief and weapons of choice  You need to have 

some inkling of what you’re going to develop. It could be one word, or a 

paid work, briefs are typically given to you and that narrows down a lot of the 

drove our initial sketch. There’s a smaller sub drone in the image sketched with its 

that even at an early stage, with only a few lines, we were thinking dynamically 

getting rolling with a Moleskine sketchbook, a little Tom Binh bag that holds it, 

an Apple  iPad and a Microsoft Surface Pro 3. It’s our little arsenal for purging 

whenever we want.

02

04

05
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Nail the scale  Having decided that the torpedo was going to be a known quantity, we searched for a 

period-appropriate model used by the navy at a particular time in history. A little reading later, we found a few 

models of torpedoes that made some sense and could serve as the backbone of the design’s scale and historical 

reference in object form. This is a massively important point, as we’re now committed to a form and a time for the design 

to be rooted in. We made an underlay of the torpedo and built it in Maya. We kept the Maya models at a one unit to one 

centimetre scale, as V-Ray likes that for its real-world lighting accuracy. While we weren’t committed to a renderer, we 

liked knowing it could be used there. It was a relaxing build, as we knew that the viewer would see it and think, ‘oh! I 

know what that is!’.

Rabbit holes As we did research on the torpedo, we went down a few rabbit holes of other information that 

we found interesting on the subject. Allow yourself this luxury! It’s all relevant, and you’re loading your palette of 

reference: both visual and factual. Some things we hit were torpedo tubes, torpedo storage, torpedoes being mounted 

on aircraft, depth charges and a few other technical tidbits that gave us an inclination on how these antiquated 

weapons were deployed and tracked targets. The sub drone would be used as a short-range taxi for depth charges 

and torpedoes, shuttling the armaments to deploy to targets at close range. They’re manoeuvrable, hard to track, and 

carried no human cargo, it could ram the target if need be. It’s a bit like a Zero, only from the Luftwaffe. We imagined 

the guidance systems on torpedoes would be developed further and applied to these drones. The whole design 

for the sub drone wasn’t complete, but it was getting more and more rooted. We had a real direction and could start 

developing around the torpedo model.

“Once you sketch something, usually in a top view for easier 3D 
understanding, challenge yourself to sketch it again”

Genius Guide
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Colie Wertz shows us 
his favourite pieces

Genosuit 
Maya, Procreate (2013) 

 This is an exosuit for use in zones 
where biowarfare has played a role. 
This image started out as a sketch in 
the Procreate app on the iPad, was 
augmented in Maya, then sent back to 

Jai-alai robot
Maya, V-Ray, MARI, Photoshop (2013) 

 Originating in Spain, Jai-alai is a 
robot that found its way to Miami, 
Florida then disappeared, eventually 
resurfacing in an underground 
gambling circle in Shanghai. 

Lander
Procreate (2015) 

 I’m discovering that I can get a lot of 
ideas and inspiration from almost 
anywhere. I have a sketchbook and 
pencils that I carry around with my iPad 
with Procreate on it.
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“Maya’s UV tools in the 2015 version are pretty great. You can enter a live UV scenario in 
which you can pick edges, separate and see what you get in the UV editor, then change 
your cuts to better serve your purpose in paint. This is a painless alternative”

UV maps  We used 

Maya and ZBrush for 

UVs. Maya’s UV tools in the 

2015 version are great. You 

can enter a live UV scenario 

where you pick edges, 

separate and see what you 

get in the UV editor, then 

change your cuts to better 

serve your purpose in paint. 

This is a painless alternative to 

the past. That said, with MARI 

it doesn’t really matter. We 

tend to ship baked, smoothed 

parts over to ZBrush, run a UV 

unwrapper, and call it a day. 

We like doing this as it shows 

how accurate and fast it is. It’s 

literally a button – UVing is too 

much work when you’re trying 

Pick an environment  It is imperative that a lighting environment be established 

as early as possible in your design if you’re working toward a deliverable of either a still or 

animation. Light shows off your model, and how that light can best show your model off is easier 

all that you need to inform you of how you can detail your design and determine depths of details 

for future use!

Concept

Build with educated purpose  With the 

establishment of a history and place where your design would 

exist, you can sketch out scenarios that would give your vehicle/

character more believability. In this story, the sub drone would need 

to be launched, cruise, splash down, navigate and deploy. For the 

launch, we chose a Messerschmitt Me 262 engine pair that would 

and this would be built about the same time. These engines would 

be smaller than those on the aircraft, but of the same design so we 

got orthographic underlays from Google, put them into Maya and 

built them. We made the size work with the pre-established scale and 

proportions. There’d need to be a propeller/screw for the aquatic part 

of the mission, so we did research on the dive planes and screws of 

subs. There was a great palette of parts from the past that we could 

use for the form and function whilst adhering to the aesthetics, too. 

The fairings and wings would allow the sub drones to be stored on 

ships for deployment, as they folded to save space. 

08

09

10
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UDIMs rule  Line up your UVs in a row of tiles: 0-1, 1-2, 2-3 and so on. This will allow you to see all of your maps in the editor and their corresponding parts. 

Back in the day you could stack them all in 0-1 space – don’t do that. If you ever decide to go to MARI, it won’t work. MARI enables you to work on multiple 

maps at once because of UDIM space. So why not make full use of it! Pick a naming convention for your shaders in whatever program you use to correspond with the 

UDIM space they occupy. For example, use ‘uv1001_subdrone_vRay’ as the name of the shader for a group of parts living in UV space 0-1 using a V-Ray shader. This 

will enable you to look at your shader and know what you’re up to if you’re not working on it straightaway, for example if it’s a week down the road. It’ll make life easier 

especially when you start spraying parts. Think of it as working from big to small with your initial shaders taking on the biggest, known amount of planned parts. You’ll 

probably add pieces to your model later down the road, and you can plop those new parts in a new UDIM with a corresponding shader name. That shader might have 

a name that describes what that part is as it’s an addendum.

Paint it Once everything that you want paint on has 

UVs, save an OBJ and send it to KeyShot. You can 

certainly stay in Maya and play with mental ray – we prefer 

dealing with a still for the project. Remember, the sooner 

you’re troubleshooting and directing your paint and maps. 

Get in there! Now you have a working model that lives in 

Maya, KeyShot and MARI. You can test as you paint. Use 

MARI’s channels and layers to build up all kinds of different 

aspects of your paint job. For the sub drone, we have used a 

parts layer, a dirt layer, a decal layer and a scuff layer. With 

the controls in MARI, which are not dissimilar to Photoshop, 

application. Once you’re done getting a fresh pass of paint 

on your model in MARI, save out your baked maps that 

correspond to your similarly named shaders in KeyShot 

and Maya. For instance, your output from MARI for a texture 

might be ‘uv1001_DIFF_01.png’. This is for your parts living 

version should you decide to change it. It’s clear and short. 

No need to muck around with where the part lives on your 

model, just think about where it lives on your shader.

Genius Guide
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Render it We chose KeyShot for this render. There are some controls in more sophisticated render packages 

Concept

“Use MARI’s 
channels 
and layers to 
build up all 
kinds of 
different 
aspects of 
your paint 
job. For the 
sub drone, 
we have 
used a base 
colour layer, 
a camoufl age 
colour layer, 
a mechanical 
parts layer, a 
dirt layer, a 
decal layer 
and a scuff 
layer”

MARI paint templates

Lookdev 

13

14
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Comp it

Genius Guide
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“We used the 
Overlay Transfer 
mode to marry 
the background 
and sub drone. A 
vignette further 
marries the two”

Your design or model will have some reason for existing. Because it exists in a particular time and place, 
you can springboard off of existing things of that era, and invent new ones that serve to support your new 
entrant in that place. For my sub drone, I sketched some elite divers and modelled custom rolling racks for 
loading and unloading both armaments and the drones onto catapults on ships. Because the navy didn’t 

World creation

15
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Concept

Concept

I wanted to make a mech heavily 
infl uenced by maschinen krieger, with a 
heavy feel and layers of details and 
plates that are gritty and worn from use.
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In these steps we will give an overview of 

some of the main steps taken when building 

complex mechanical models from the idea 

We will explain the thoughts 

our chosen order. The focus is on kitbashing and quick 

Fantasy Art Genius Guide  55

Assemble your mech
Identify potential kitbash pieces

Kitbash and 
model a mech
Build a semirealistic render, showing off the design of the mech

  

Tor Frick
www.torfrick.com

Artist

working in the 

an art director. I spend 

machines.

Source Files

Software

need to recreate this 
incredible artwork.

Create the blockout This might sound like a no-brainer, 

but it’s worth mentioning. The foundation to a good 

workfl ow starts with a good blockout. It’s good to identify 

kitbashing methods and pieces as early as possible. By fi nding 

reoccurring shapes in the blockout, we can plan our kitbashing 

elements ahead. For example in this model we have relied on 

cylindrical elements, hinges and dif erent kinds of rails in the 

detailing and construction of the mechanisms.

Assemble kitbash pieces and details Using the blockout as a base, 

we can identify possible kitbash pieces as well as fi nd the style for the 

detailing. Create a decent number of kitbash pieces that you think will be enough 

to cover most situations on this model. Throughout the modelling phase keep 

adding to the kitbash library as you will fi nd reuseable elements while building. 

Try not to create details that are too specifi c with the pieces so that you can 

reuse them easier.

Set up the scene 

When working with 

any kind of complex 

model, it’s good to take the 

time to set up a solid scene 

structure, as well as things 

like mirrored instances. A 

good method is to have 

the instances and 

mirroring set up correctly 

from the start, so that we 

can see the end result of 

the model at all times. It’s 

also good to set up 

animated parts with test 

animations, so that we can 

make sure that things 

work the way we want 

them to without 

accidentally ruining 

mobility or functionality.

01

03

02

“By fi nding reoccurring shapes in the 
blockout, we can plan our kitbashing 
elements ahead”
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If you are working on a series of models that are sharing the 
same underlying design principles or style, kitbashing is even 

constantly growing your library helps maintain a visual style as 

dissect your model after completion in search of good kitbash 

Reusing elements

Main modelling stage This is the biggest chunk of work for the 

model. Go through the entire model and model out all the main 

elements, or replace blockout parts with kitbash pieces, then do a detail pass 

using the kitbash pieces and fl esh everything out to a near-fi nal state. After this 

step, the majority of the mech has been modelled. During this stage we used a 

lot of Booleans in the modelling, combined with reused parts to speed up the 

process. It is during this stage that it’s easiest to fi nd new material for the 

kitbash set.

Freeze the fusion After we are done with the MeshFusion modelling, 

freeze a copy of the fusion mesh and start to model with that as a base. 

We do this because MeshFusion can get quite sluggish when you abuse it too 

much with many separate pieces. Separate the mesh into pieces, like the cockpit 

lid and the base, and start to do more detailed modelling and panelling on it. Use 

MODO 901’s new cutting and capping tool to create quick panels and seams in 

the mesh.

Set up core 
materials and 

colours Set up the core 

materials early on – this 

enables us to keep track of 

how noisy the fi nal model 

will be visually. This allows 

for easier focus on the 

modelling and a better 

distribution of the elements 

because we will be able to 

catch cluttered or drab 

areas earlier. It also speeds 

up the texturing and 

shading process, since the 

majority of the materials 

will already be in place. It 

also saves time since we 

will be copying and pasting 

a lot of elements around.

MeshFusion base elements For some of the main elements of 

the model like the cockpit, use MeshFusion to iterate quickly on the 

large shapes instead of on a traditional mesh. MeshFusion works best 

when you have large complex shapes and forms that do not need to match 

an existing design. It allows for very quick experiments with shapes such 

as this. Spend some time experimenting in this stage, deviating from the 

original idea a bit to see if we fi nd something new since the iteration speed 

is so fast. The rest of the model is hidden for clarity.

MeshFusion polish After getting the base 

shapes right, convert the MeshFusion to a 

schematic fusion, which enables us to do a few more 

complex things like layering the fusions on each other. 

Spend some time adding additional detail to the 

MeshFusion as well as cleaning up the angles and setting 

up the correct hardness of the intersections. Add all the 

large and medium-sized shapes needed for this part of the 

model – basically, add everything that needs large, soft 

transitions. Leave fi ner details out of MeshFusion entirely.

04

05

06

07
08
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If you are aiming to texture and render the high-poly model 
properly, make sure to UV your kitbashing pieces before you 
start redistributing them in your model. That way you have 
already done UVs for a large part of your model from the 
get-go. Even if you alter a lot of the geometry later, the base 
unwrap still carries over.

Do your UV maps earlier!

Kitbash fi ller For areas that are hard to see, or out of focus, kitbashing can be a great 

time saver. Sometimes you need to fi ll large holes or areas with details, but doing them 

all by hand can be time consuming. A few areas of the mech could do with some more fi lling 

out, so just reuse existing parts (since this is not an area you will see all that well) – making it fi t 

together is not so important.

Cover up the kitbashing Once we have used the 

kitbash pieces everywhere, it starts to look overused and 

you can spot the repetition if it’s not hidden well enough.  

Always take a quick pass to change some of the more obvious 

reused ones by adding or subtracting elements from them. The 

majority of the touchups we do includes rescaling parts of a 

kitbash element or just deleting parts of it, or covering/adding to 

it with some additional simple shapes. Most of the time, simple 

changes are enough to get away from repetition.

Sculpting and cloth To 

break up the monotony of the 

metal surfaces, it’s a good idea to 

introduce some cloth and additional 

equipment (like bags for example). 

Parts of the cloth is sculpted in 

MODO by using the sculpting tools, 

which are great for quick, basic 

sculpting. For the more complex 

parts like the bags, we used 

Marvelous Designer combined with 

some quick shapes to simulate bags 

with packing in them. They are then 

instanced out in MODO so that the 

fi le does not explode in size.

Set up the 
fl oaters 

Before we do the very 

last detailing step with 

fl oating details, we 

need to create a small 

selection of details that 

we can clone out over 

the model. A selection 

of rivets and dif erent 

small insets is more 

than enough for this 

model. A good trick is 

to give them their own 

material, so that you 

can easily mask them 

out if needed.

“Before we do the very last detailing step with 
fl oating details, we need to create a small selection 
of details that we can clone out over the model. A 
selection of rivets and different small insets is more 
than enough”

09

10

11

12
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Fine detailing This is the fi nal detail pass where we add 

the rivets, small details and so on. The reason why we do this 

so late is because it can make or break a model. Sometimes it’s 

hard to know what you have until this the model is almost 

complete. We do not want to create overdetailed areas, or cover 

areas of rest with small detail. The Tack tool and Clone tool are your 

best friends when it comes to placing detail meshes in MODO.

Set up the decals The same way that we set up kitbashing elements earlier, set up 

a number of decals that we can combine: a few generic warning signs, some 

numbers, as well as some custom decals. Create these as separate mesh planes with a 

texture so that you can place them more easily using the same tools, the same as when 

placing the mesh details.

Rendering 

13 14
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Set up materials Set up some 

instances of the materials so that you can 

easily create more colour variations without 

having to create new base materials from 

scratch. We do a lot of the colouring by just 

tagging materials instead of adding textures to 

the model, saving us a lot of time when doing 

quick designs. Do not be afraid to create extra 

cuts and lines in your model only for the purpose 

of assigning colours. The main colour variation 

in the mech comes from material instances only. 

A simple tiling Bump map and dif use texture 

are all that drives the main material.

Place the decals and text The same way that we were holding of  on 

adding the small detailing like rivets and so on, we hold of  on adding 

decals until the end. We don’t want to end up with a cluttered model with too 

many decals in obvious copied-and-pasted locations.

Postrender tweaks After rendering out the model, we take it into Photoshop for some quick touchups to 

get our fi nal image. A quick trick is to render out an ambient occlusion layer and multiply that, combined with a 

colour to get a very basic dirt pass for the render. To get away from that artifi cial look, play with the layer blending and 

manually mask away parts where the AO is too strong. A few quick material overlays can get you a long way.

“ We do a lot of 
the colouring by 
just tagging 
materials instead 
of adding 
textures to the 
model, saving us 
a lot of time”

Discover the sci-fi  
worlds of Tor’s art

Steampunk microscope
MODO, Photoshop (2015) 

 A study in modelling and shading, 

for a bit. 

MODO, Photoshop (2015)
 

in MODO. 

MODO (2015) 
 

larger scene to test out new 

shaders only.

An alternative way to 
create the decals is to 
have a decal sheet as an 
image only, and then 
camera project UVs from 
the viewport onto the 
decal sheet. That way 
you do not have to 
bother with planes for the 
decals, and it can make 
things easier.

Decals
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Character
From magical to steampunk

62 Create a convincing cartoon character

68 Texture distinct steampunk characters

76 Perfect colourised characters

82 Colour your fantasy composite

88 Develop your own mutant

94 Make your own steampunk captain

100 Retouch a fantasy sorceress

106 Render a cyberpunk character

114 Design an Elven archer

120 Fashion pro key art

126 Add drama with blend modes

62

68

76 120
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This tutorial covers a basic 

areas such as a basic way to start a 

While there are tons of 

different methods, here we show you a 

aspects so you can focus more on the 

shape, silhouette and other creative 

aspects. We will work with Maya, 

the technical aspects and all of the 

equivalent software.

Create a convincing 
cartoon character
Render a charming cartoon pin-up, prepare a hairstyle and 
complement a scene with organic ornaments and lighting

“If you get the shape of the head 
you want with a small amount 
of geometry and a smart 
topology it becomes easier to 
predict when and where to add 
or delete new edge loops”

head to create the neck. Using the Sculpt tool, smooth the new edges to get a round shape.

We create the nose 

modelled in parts, starting with a simple row of polygons 

shaped as a spiral section. We don’t need a fully detailed ear 

By deleting some faces on the head and leaving the same 

attach it to the head using a Bridge operation.

01

02

03

A common error is trying to get a lot of detail from the start, 
if you get the shape of the head you want with a small 
amount of geometry and a smart topology it becomes 
easier to predict when and where to add or delete new edge 
loops. That being said, don’t be afraid to add new edge 
loops for further detailing without the fear of losing the 
shape you already had. Tools like Edit Edge Flow, the Slide 
Edge Tool and the relax and smooth operations in the 
Sculpt Geometry tool are really powerful for smoothing out 
an organic, dense mesh.

Take control of every 
vertex created
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Concept
I’ve always loved the elegant mix of 
organic ornaments and fabrics that 
are frequent in the art nouveau style, 
this was in part inspiration for this 
piece, which started out originally as 
a quick sketch.

Carlos Ortega 
Elizalde
carlosortega.
prosite.com

Artist

Carlos is a 3D artist who 
has worked on various 
freelance projects 
including several M&M 
holiday campaigns.

Maya, Mudbox, 
Photoshop

Source Files

Software

and tutorial screenshots 
to help you complete 
this tutorial.
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Build the torso The main shape of the torso is 

basically a cylinder. With a few divisions we start to block 

the base of the neck, the shoulders, the waist and the hips. With 

04

Build the arms, legs and feet The arms and 

since our character will have shoes.

05

Model the hands 06

Merge the pieces together Attach all the limbs 

to the torso, and smooth out the joins if needed. Add 

some clavicle detail on the body since it is a part of the body 

inside the iris.

07

Make the dress
duplicate of the body, this way we will make sure it will 

The cloth extension is just an extrusion of the bottom half of the 

08
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You can easily block the hair geometry using polygons by thinking of hair as 
broad shapes or clumps instead of hundreds of individual elements. By 
keeping a ‘grid’ or ‘patch’ topology on the geometry of the strands, it can lead 
to different styles of output depending on your needs. You can use the 
geometry to get an appealing cartoon look, use transparency and bump maps 
to get a more detailed look, or create curves from the geometry to grow a more 
complex and dynamic hair system.

Plan the hairstyle

Add the skirt and accessories The skirt is 

created in two parts, the folds can be easily created by 

using a cylinder and pulling out vertices to create the folds. After 

extruding and shaping the bottom part of the skirt attach it to 

the hip’s geometry that was previously extracted from the body. 

The shoes are created using geometry from the feet, and then 

building them around the foot. For things like earrings and hair 

ornaments, model the elements and then combine them to create 

each accessory, this adds a consistent style by having repeating 

patterns across the model.

09

Build the hairstyle The hair here is divided into two 

parts – one covers the skull and the other is formed of long 

strands in the back. For the calvaria we can start with a sphere and 

delete the poles to easily get the basic strand shapes coming from 

the forehead to the back of the head. Keeping the topology as grid 

patches is pretty useful for converting later to a Maya hair system. 

For the long strands of hair in the back draw the main shapes using 

CV curves. Then, build eight blocks of hair by extruding a circular 

plane along the curves.

10

Detail the hairstyle Use the taper and twist functions 

in the Extrude options and sculpt the resulting mesh to 

get variations in volume and shape. Now extract the curves that 

will serve as guides for the hair. Select the Edge Loop and go to 

Modify>Convert>Polygon Edges To Curve. You will need to do 

this for all the necessary curves. There are free scripts on Creative 

Crash that can automate this process. Too many curves can lead 

to a heavy system and too few curves can force you to grow wider 

silhouette of your hairstyle.

11

Finish the hairstyle Next step is creating two hair 

systems, one for the head and another for the long strands. 

Select the head curves and go to nDynamics>Hair>Assign Hair 

System, then assign a PaintFX brush to Hair. Now you can adjust 

the clumps’ width and shape, hair thinning, number and width of 

hairs per clump, and hair shading. Keeping the original mesh of 

the hair without deleting history in the curves lets you modify the 

polymesh directly to tweak the hair and transfer those changes to 

the hair system. By default the hair gets dynamic properties, and 

you can change it to static for a still image like this.

12
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UVs and texturing The improved unfold tools 

in Maya will let you unfold the body and cloth meshes 

easily, one UV tile per material will work great for this model. 

Moving to Mudbox, paint the textures of the character. You can 

start with a skin colour base and add yellow, orange and pink 

tones in the nose and ear areas, and purple tones in the eyes. 

Using references is a good way to know where those tones suit 

better. Now paint more maps such as a deep Scatter, Specular 

and Glossiness map. We will plug those to our skin material.

Pose the model Create a basic skeleton in Maya, drawing the joints from the hips up 

to the tip of the head, then legs and arms. Using the Snap to Projected Center feature will 

the skeleton to the main mesh using the Heat Map option and Quaternion method, and since it 

is a skinny character this option works well by default. We can then skin the clothes and copy the 

Lay out the scene To complement the scene we will add some natural elements that 

will suit the atmosphere and colour palette. We will add a simple terrain which we can sculpt 

and detail in Mudbox. The tree can be quickly created in ZBrush – we don’t need to overdetail the 

model, since the whole feel of the scene is smooth and more like a fake set rather than a realistic 

Bonus Tools 2015. Its ease of use will let you quickly grow some plants and throw some rocks on 

the ground.

Detail the model Once posed, send the character 

neck and knees. We subdivide the dress a couple of times, 

elements. Most of the silhouettes of the objects were solved 

with pure polygon modelling, so at this point, bake some normal 

maps of the cloth to get all the folding details. Then export all the 

elements with one level of subdivision to save some render time 

and avoid the use of displacements.

Learn to observe everyday life and how the human 
body acts, balances itself and moves so you can 
start to create natural and balanced poses that 
pushes limits in a believable way. Here, the shoulders 
tilt in the opposite direction to the hips to compensate 
the weight. The pose is almost an S shape, 

get a solid composition and guide the viewer from 
the face, down to the fabric on the ground.

Getting a 
graceful silhouette

13

14

15

16
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“Learn to observe everyday life 
and how the human body acts, 
balances itself and moves so you 
can start to create natural and 
balanced poses that push the limits 
in a believable way”

It can take a while to get a decent look with materials like the skin shader. A 
suggestion for this kind of cartoon character is to not look for realistic results or 

Be

17

19

18

20

Materials in mental ray This scene uses the mia-material-X, the misss-fast_skin 

shader and blinn materials. It is useful to start playing with the Scale Conversion option 

on the skin shader to make it work, since the shader will depend of the size of your object. Plug 

the textures and be sure to gamma-correct each texture or work your scene with the Color 

so that it gets more transparent and is at a glancing angle. Use glossy refractions objects, which 

will become blurred when seen through the fabric.

Rendering The scene is rendered with mental ray and 

Final Gather. For large resolution renders like this, it’s useful 

to bake a Final Gather map at a lower resolution and then freeze 

it to save some render time. By default the skin shader takes into 

account the resolution of your scene to compute its light maps, be 

reason, we will render the scenario and the character in separate 

render layers using a 32-bit EXR format.

Finish the image Some useful layers to render during image compositing 

are a good set of masks, a depth pass and in some cases a normal pass. In 

Photoshop, use the depth pass, and add atmospheric elements such as fog and 

or exposure of different elements without struggling with selections. We can create light 

effects by painting 

with soft brushes 

and setting layers 

to a Screen or Add 

mode. The dust 

particles are just 

brushes with high 

scatter values 

and different blur 

settings for a 

feeling of depth.

Lighting The light rig consists of four lights: key light, 

blurred HDRI.
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In this tutorial we’ll be taking an 

overarching look at some 3D character 

 We will go through the process 

of constructing characters, from basic modelling 

and sculpting to building textures and materials, 

posing and rendering. We’ll be creating a 

steampunk scene with two characters that are very 

different from a technical standpoint. Each 

character will present us with a distinct set of 

challenges, which enables us to explore a variety of 

machinist, we’ll get to practice an organic character 

and sculpting anatomy, clothing and accessories, 

as well as tools for quickly unwrapping clothes and 

baking perfect detail maps. Our guardian character 

will have us work through balancing the character’s 

motion functionality and aesthetic appeal. We will 

also explore techniques for quickly texturing 

metals and building convincing materials. Finally 

we’ll build a quick environment and set up our 

scene for rendering. 

Texture distinct 
steampunk 
characters
Master the creation of two technically different characters: 
a steampunk machine-maker and his giant, steam-
powered mechanical marvel

Aldo Vicente
www.aldo 
vicentecg.com

Artist

Aldo is a 3D generalist 
based in California. He 
currently works at the 
Medical Tech industry 
creating 3D 
Visualisations for 
Aurora Spine.

Maya, ZBrush, Photoshop, 
RoadKill, XNormal

Source Files

Software

the tutorial screenshots 
and a video tutorial to 
complete this tutorial.

Start with a rough pass
Work out your character’s shapes

Guardian block-in Let’s start with a quick, rough pass. This block-in gives us an early look at our character’s overall shapes and it’s important since 

our character’s proportion, overall feel and personality will get lost between the concept art and the 3D model. By blocking in the full character as quickly as 

cleaning once our block-in feels like our concept.

01
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“Hard surface 
parts can 

create very 
rigid-looking 
forms, so it’s 
important to 

emphasise 
the S-curves 

in our design”

Concept
I wanted to create a Victorian era machinist and 
his creation; a giant steam engine, built for military 
defence. The designs are steampunk-inspired, 
with a heavy industrial emphasis.

Genius Guide
Fantasy Art
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Build our parts library Now we can start looking at our overall 

Clean our mesh

Build the 
anatomy 

Lock down the look

02

04

05

03

“Delete the back faces on our 
guardian’s outer plates. This will 
reduce poly count, save UV space 
and make unwrapping easier”
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Sculpting clothes wrinkles can take a lot of practice and iteration. 
It’s about getting in the right mind-set rather than any particular 
brush or technique. I recommend starting with an exercise to help 
get a feel for cloth folding. Create a simple sphere on a ground 
plane, with a plane right above it. Imagine the above plane is a 
tablecloth, and try sculpting how it would land if you were to drop it 
onto the sphere on the ground. Try this same exercise with more 
complex shapes, and imagining different types of fabrics. This 
helps us warm up and get a really solid grasp of how clothing and 
folds work.

Sculpting warm-up 
exercise

Model clothing and accessories Let’s bring our machinist 

mesh back into Maya, and make sure our character is at real-world scale. 

Split up our model into the basic areas of our head, shirt, gloves, pants and boots. 

We can repeat the process to create geometry for the vest, belt and harness. 

will be done in ZBrush. We can use basic box modelling to shape the belt straps 

and harness.

Prepare our costume for sculpting First, we should be sure 

again that we have neat, even edge distribution. The majority of this 

should have already been in place from our machinist anatomy model, but we 

can use the Quad Draw tool in the Modeling Toolkit to quickly and easily make 

extrude our border edges, for the reasons listed in Step 4. We could do UV 

layouts at this point, but it may be preferable to do it after sculpting as some of the 

geo may change considerably, and our UVs may need to be redone.

Sculpt the clothes 

Here we’ll be sculpting in 

the large and mid-level detail of our 

clothing. This includes the overall 

structure, drape of our clothes and 

the wrinkles. We won’t be sculpting 

threading and stitching of the fabric, 

as we’ll be adding those details via 

our textures later. It’s good to have 

reference of the types of fabric each 

piece is made of. Keep in mind that 

these are just panels of fabric falling 

over simple anatomical shapes. 

to stay generic enough to work in 

most poses.

06

07

08 “We won’t be 
sculpting in the 
fi ne detail such 

as the threading 
and stitching of 

the fabric, as we’ll 
be adding those 

details via our 
textures later. It’s 

good to have 
reference of the 

types of fabric each 
piece is made of”
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Lay out the UVs To unwrap our clothes, we’ll use 

RoadKill, a free plugin for Maya. We can select our vest 

mesh, and run the plugin. In RoadKill we double-click to select 

the shoulder seam edges and hit C to cut the UVs. Instantly, we 

repeat this to separate the lapels and we’re done. If we want 

to smooth our UVs out further, headus is another free option 

with an excellent UV-relaxing algorithm and a very simple, but 

Create the metal textures Now we should 

export our Polypaint data as a texture map and bring it 

into Photoshop as an overlay layer with our base metal colour 

underneath. The grey in our grunge map will disappear, leaving 

us some dark grunge and light scratches that will go over our 

base colour. We’ll also add a subtle metal photo texture over our 

base colour and colourise our grunge to get a rusty red hue. This 

is our Diffuse map. We’ll fashion a Bump map with desaturation 

and then invert our scratches to black. We’ll raise our base colour 

to near white and then adjust the noise layer to a medium grey. 

Paint metal grunge It’s hard to distinguish which 

UV islands correspond to what plates by simply looking 

in 2D. Instead, let’s turn on ZBrush Polypaint and subdivide our 

mesh into the millions. We can start this off by coating our mesh 

in 50 per cent grey. Let’s set our brush to RGB Color Spray with a 

grungy alpha and zero z-intensity. We’ll paint in the edge grunge, 

rusting and scratches. At this point we are only concerned with 

colouring this detail onto our mesh. Grunge and rust should be 

darker values while scratches should be a white colour.

Unwrap the guardian Our guardian has a lot of internal and external parts, but we 

can save a lot of time and UV space by using 3D procedural textures on the smaller, less 

visible internal parts. We’ll only unwrap the outer metal plating of our guardian. Let’s select our 

plated parts, export them to ZBrush and run the UV Master plugin. Because of the cleanup and 

double extrudes back in Step 4, our plates are essentially curved planes with structured border 

edges. This makes them ideal for the UV Master algorithm. Almost instantly, we get a clean, evenly 

scaled UV layout for all our plates.

09

10

11

12

Image-based 
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13
14

15

16

Create metal materials

Bake good maps

Texture the equipment 

Texture the machinist 

Normal casts rays from the lower-res mesh surface to the hi-res surface. The 
rays’ travel distance and normal data is written as colour data to the UVs of the 
lower-res mesh to create our maps. However, there is a travel distance threshold 
– if the rays travel past that distance without reaching the hi-res surface, they get 
ignored and no data is written to the map. This is why we use cages around our 
meshes instead of distance thresholds. The cage surface becomes the new 
distance threshold, ensuring we collect all the hi-res data, with optimised 
calculation time.

Map baking in XNormal



Character

“With the help of ZBrush 
Polypaint, we’ll colour 
in the rusting and 
scratching around 
our equipment’s 
nooks and edges”

Character
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Make a background environment Let’s 

create a simple ground or wall backdrop. We’ll give the 

wall extra edges to indicate where the brick meets the concrete 

segment. We can use planar mapping to quickly get UVs. In 

Photoshop, we’ll use photo textures of bricks and concrete to 

create a quick Diffuse map. We’ll balance the levels and colours 

a Bump map by desaturating and pushing recesses into black, 

while pulling convex surface space up to white. To add depth to 

our environment in Maya, we can apply a bend deformer and 

create a rounded wall.

Render our scene Let’s set up render passes 

Settings>Passes, we’ll create and associate beauty, AO, diffuse, 

three. We can render and save these passes out individually for 

compositing in Photoshop. We should use ‘Linear Dodge (Add)’ 

blending mode to put our passes together and re-create our 

beauty pass. Finally, let’s create a custom matte pass, assigning 

different coloured surface shaders to each character and the 

Build the remaining materials We’ll need to 

build several different material types for our equipment. 

With our maps ready, gather reference and create some fresh 

MIA materials. First, name all our materials, turn on Use Fresnel, 

can start balancing the Specularity and Diffuse, knowing that 

strength, and the shade strength from zero to one. With MIA’s 

energy conservation math in mind, we can solve for really 

Clothes shaders Let’s import our machinist 

textures and plug them into a new mia_material_x_pass. 

cloth detail. Both will be plugged into the shader. The cloth for 

our vest, pants and shirt is generally pretty diffuse, with very low 

as looking at cloth at direct angles is especially dull. We can add 

a tiny bit of translucency, or we can fake it by plugging in a very 

weak mia_self_illumination node.

17

18

19

20

The MIA materials are physically accurate, meaning 

MIA energy 
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The golden ratio 
(also called the 
golden section) is 
approximately equal 
to 1.618. It often 
appears in nature in 
things like shells 

has been used by 
many artists and 
architects to create 
beauty and 
harmony in their 
designs. Use 
Photoshop’s 
Golden Section 
plug-in to position 
points of interest in 
your image along 
the lines of the 
spiral and over 
the intersections.

Apply 
ratios

Illustrations don’t always have to be 

hand-drawn from scratch. By manipulating 

stock imagery and adding effects, you too can 

create a fantasy scene like the one seen here. 

that chooses who lives and who dies in battle. This 

illustration portrays a valkyrie in Valhalla, a heavenly 

hall, as she prepares to descend to Earth. The image 

had to convey her as dynamic, as well as being bathed 

by light seeping through the gates.

This tutorial will outline some of the key tools and 

functions of Photoshop that are most useful to 

illustrators. It will show you how to add colour to a 

scene, how to manage a bright atmosphere and will 

simplify the rules of composition. To complete this 

image, you will need to download or create a selection 

of custom brushes. You will call on numerous tools, 

adjustments and blending modes, which will all be 

useful to you in future. Experiment with brushes to 

from the internet or your own libraries as references for 

your illustration.

Here the artist used Photoshop CS6, but you can 

follow this tutorial using any version from CS4. Before 

you start, download the stock images from 

76  Fantasy Art Genius Guide

Build a fantasy scene
Import the background image and add lighting effects

workspace Create 

a new document and import 

the background image named 

‘reference_picture.jpg’, available 

from FileSilo. Search for angel 

images on the internet or in 

your personal library to use as 

references for your illustration. It 

is important to choose these well, 

as they will give you ideas 

for composition.

Build the scene Download 

paint and pencil brushes from the 

internet. These site are useful: 

photoshop.fr,  and 

myphotoshopbrushes.com. Go to Brush 

Presets and click the top-right dropdown 

menu, then select ‘Load Brushes’ to import them 

into Photoshop.

01

02

Perfect 
colourised 
characters
Master digital illustration techniques and learn how to 
colourise with the Brush tool

Character
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Nicolas Delhelle
www.facebook.com/
ndelhelle

Artist

Nicolas Delhelle is a 
French freelance 
illustrator and a 
decorator for Ankama 
Games and Wakfu 
anime. He has worked 
alongside publishers in 
both the book and 
magazine industries.

Photoshop

Source Files

Software

On FileSilo you will 
he stock imagery 

used to create this 
artwork, including the 
background and 
Roman columns.

Concept

Genius Guide
Fantasy Art
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Create shortcuts 03

First lighting effects 04

Painting effects 05 Give movement to the rays 06
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Photoshop’s Color 
Picker is very 
useful, as it allows 
you to preview 
colours in several 
variables of 
luminosity, hue or 
saturation. You can 
attribute a hot key 
to this selector to 
always have quick 
and easy access 
to it and place it 
where you want on 
the screen. You 
can do this via 
Edit>Keyboard 
Shortcuts. This is a 
very useful trick. 

Pick 
colours 
with 
handy 
tools

Build your columns Import ‘roman_columns.

jpg’ and use the Selection tool to isolate one of the 

columns from the scene. Once complete, make a new layer 

mask. Duplicate this individual column four times as seen on 

the screenshot, then colour the columns in yellow with a Hue/

columns, so that the light on the columns is coherent with 

the scene. Press Cmd/Ctrl+T or Ctrl/right-click and choose 

Transform Selection. Then Ctrl/right-click again to transform and 

select Flip Horizontal.

07

Finish the door and add effects You will 

now need to polish up the background with several 

paint brushes. Once that is done, you can play with blur effects, 

reverse effect by adding blurriness to certain areas

08

Rays of light Go to the Paths tool and create a new path. Call it Trace 1. Here, highlight the path and 

click on Trace1. Draw lines that start from the gate to the outside edge of the image. This tool is useful 

when you have to draw many lines. Before going any further, select a wide brush with a paint effect. All these 

lines are on a path layer, so Ctrl/right-click the layer, and then you can select Contour and the Brush tool.

09

Outline the valkyrie The most 

dynamism to the character. Here I chose an angel 

model images as reference. I began by drawing a 

female form, then added wings, hair, armour, a veil, 

shield and sword. You can also draw each element 

with different colours to give an idea of what you 

want. Make sure you create a new layer each time 

you add anything new.

10
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Light and shadow Once the outline sketch is complete, quickly paint in the shadows 

and the light of the angel using only two colours. It is very important to determine a light 

direction so the scene looks realistic. In this image, the light is coming from behind the valkyrie. 

Always bear the light source in mind when integrating objects into a scene. Play with the areas of 

light and shadow to give them an interesting shape. Also try building a hidden silhouette.

11

Finish the valkyrie Here you will attack the most 

complicated step, which requires a certain amount of 

add the armour afterwards. Take a paint brush to paint each 

part of the character. Respect the lines of your initial sketch and 

the values of the shadows and lights. While you paint, click to 

vary the opacity of the brush, for example, make four different 

changes to the opacity, ending up at 40 %.

12

The veil Download the texture ‘veil.jpg’ to use on the 

valkyrie’s own veil. The tricky part will be trying to make 

the fabric look realistic and show the movement. On the photo, 

the valkyrie’s veil. For fabrics, the shadows should be very 

deep to give the impression of folds. This is a very useful 

technique to master.

13 Sword and shield Research images of swords and shields on the internet to 

use as reference when illustrating your own. Useful sites include boutiquemedievale.fr, 

toutesvosrepliques.com and heavenlyswords.com. Bring all your references together to help 

inspire you. If you do not want to import the images but merely use them for reference, create a 

Mini Bridge in Photoshop, which will allow you to have access to your reference images without 

importing them into the document.

14
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Brushes are almost inexhaustible tools, as thousands 
exist. Some serve to just create a spot or a texture in 
a single click and other types of brushes give chalk, 
pastel and oil paint effects, among others. You can 

caps, and objects of all kinds in brushes. Their variety 

these brushes and to save them as custom brushes. 

Using Brushes

Colour adjustment 
18

Wings 15

Tints and smoke 16

Final adjustments 17
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This tutorial is for Photoshop fanatics who 

want to overstep the boundaries of their 

creativity.
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Combine all the elements
Resize and place image layers before adding effects

Kevin Lohstroh
Artist

Source Files

Software

Choose a size for your document Insert a 
manipulated 

background 

01 02

Combine the Warp tool with the Free Transform tools to create a whole new 

the layers into a Smart Object or merge them, and then add the warp.

Combine different tools

Colour your 
fantasy 
composite
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03
Defringe residual pixels Display the image at 100% zoom. Select 

the foreground layer of the image. Go to Layers at the top of the window, 

then select Matting and Defringe to open an option box. Enter a number of pixels 

to use for defringing. Photoshop uses the default value of one pixel for defringing. 

Click OK. Open the Defringe option box if some pixels remain and enter 

increasingly higher values in this box until no pixels appear in the image.

04

Remove details around the image Place your image in the middle of the landscape 

background. Because of the dark background there will be some details left around the image 

that should be part of your mask. Turn off Quick Mask mode, then go to Select>Inverse Selection (Cmd/

Ctrl+Shift+I). Last but not least, copy and paste the model into your main composition.

05

Determine the composition The next 

step is to determine the composition of the 

see, a sketch has been made upfront. You can use this 

as a guideline. Feel free to make any changes to it. The 

purpose is to create equality using different materials. 

These layers are included in the document. The Warp 

tool has been applied here and will be explained in the 

next step.

06

Cut out the character 
out from the background. Create a path layer using the Pen tool, tracing 

the contours of her body point by point. Once the path is closed and the shape 

is correct, Ctrl/right-click and choose Make Selection. You need to invert the 

then press Delete.
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Use the warp ability Open ‘AbstractFlower.psd’. Press Cmd/Ctrl+T to enter Free 

Transform mode or go to Edit>Transform>Warp. You will now see that your element is 

divided into rectangles, meaning that you are in Warp mode. Click on a rectangle on top of your 

selected element and drag it up, down, right or left. As you do this, your element will become 

dragging on the rectangles to further warp your image until you have achieved the desired look.

07

08

Interim evaluation Place the elements that have already been created on the canvas. In the 

and effects to bring this image together. The focus is now on making this image complete.

09

Modify the eagle Open ‘Eagle.

psd’. Modify your eagle to give her folding 

wings. The hardest part is to integrate her into the 

composition smoothly. With the knowledge of the 

last steps you can use ‘AbstractFlower.psd’ and 

make new elements with it by using the Warp tool 

or Liquify function (Filter>Liquify). Warp or liquify 

your elements until you have achieved the desired 

look. For example, cut out a piece of the model’s hair 

and bring it around the eagle. Use the Burn tool for 

shadows where it is necessary.

10

Add shapes and objects Look at the different 

types of objects and attributes that make your 

composition part complete. Use them for creating your own 

unique formation. As you’ll see, focusing on certain shapes 

and avoiding symmetrical patterns will allow you to develop 

formations that look abstract and natural. Create a mixed-media 

composition using different warp techniques, with the help 

of only a few objects of different sizes, as well as using some 

images to produce a powerful composition.

Add some extra 

skin shapes to 

parts of the 

model using 

different 

techniques, to 

make her look 

more surreal

You should 

balance the 

‘weight’ of your 

subject by 

including other 

objects of lesser 

importance in 

the empty spaces

Use the Dodge and 

Burn tools to add 

highlights, 

shadows and 

lighting details to 

the areas where 

you can place them



86  Fantasy Art Genius Guide

Character

Apply curvy shapes The curvy shapes protruding from several parts of her body are 11

Fill up the emptiness 12

13

14
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First reduce image noise before sharpening so that 
you don’t intensify the noise. Then take a separate 
layer so that you can resharpen it later to output to a 
different medium. If you want better control over 
sharpening your images, use the Smart Sharpen 

controls and options. You can sharpen your entire 
image or just a portion using a selection or mask. Be 
aware that the Unsharp Mask and Smart Sharpen 

Sharpening

Add an oil paint effect 18

Dodge and burn 15

16
17

Add sunlight 

If you have multiple layers in a layer group, instead of setting each layer’s blend 
mode individually, try setting the blend mode for the layer group. This will treat all of 
the layers in the group as if they were ‘merged’ together, then blend them as one.

Set group blend modes

Colour adjustment 
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What if Photoshop had the potential 

to deliver composite elements at the 

touch of a button? What if you didn’t 

have to spend extra time shooting elements 

Not only has Photoshop given us the ability 

Photoshop CC 2014 we are able to use the new 

step further by not only using the Render Flame 

Fantasy Art Genius Guide  89

Begin with a sketch  When trying to pull off any Light the photoshoot Whenever you plan to have a lighting 
01 02

It’s not 
uncommon to 
come to a 
crossroads 
when creating 
an image. 
Sometimes you 
see two very 
different end 
results in your 
mind. Try them 
both! Save your 
PSD under two 
different names 
and try out both 
ideas. Compare 
them and 
decide what one 
you like better. 
You may even 
decide to use 
them both for 
different things.

Try 
other 
options

Develop your 
own mutant

 
 

Artist

advertising photographer 

and does his own 

Photoshop

Source Files

Software

that have been made for 

Brandon 
Cawood

Sketch, plan and process
Be sure to consider lighting when shooting your images
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03

Mask the body The key to any great composite is having very clean 04

Mask the hair 
05

Prepare the background The main 

clouds to get the exposures about the same. Group 

and cloudy.

06

Process your subject before masking 

tight enough that any haloing or hard lines get eliminated.

An easy way to 

elements even further is 
to duplicate the layer. 
After that add a 
Gaussian Blur with a 
radius of about 30 to 

a nice soft glow. Use 

as sparks.

Blur your 
layers
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Make the eyes pop Making the eyes of your subject 

pop can really add emotion into the image. The key is to 

keep it subtle but effective. Create a Curves adjustment layer on 

top of all the other layers. When you do this it will have its own mask 

a white brush. Paint in the mask only over the pupils and iris. Now 

you want to make an S shape on your Curves layers. On your graph 

add a point about a quarter of the way up, one in the middle, and 

one about three-quarters of the way up. Leave the one in the middle 

now adjust the opacity of this layer if the effect is over the top.

07

08

Adjust shadows and highlights If you feel that your highlights are too bright or not bright 

enough you can adjust them without affecting your shadows. Add a new Curves adjustment layer 

above all other layers. Adjust the RGB channel accordingly. This is just like Step 8 but we are using the 

RGB channel instead of the blue channel. With your Curves adjustment layer selected go to Layer>Layer 

Style>Blending Options. At the bottom of the window you will see two sliders under Underlying Layer. Hold 

down Alt/Option then click and drag the right corner of the black slider all the way to the right. This will cause 

the Curves to only affect the highlights in the image. Do the opposite for shadow adjustments.

09

Use Render Flame 
on the background The Render 

quickly and effectively and it’s relatively easy! For 

buildings in the background. Create a new blank 

layer above your background. Grab the Pen tool and 

direction, the width, and much more. Choose the 

on its own layer. Turn the blending mode to Screen.

10

Colour match the subject and background  Use an individual Curves 

adjustment layer on top of the background layer. Make sure it is clipped to only the 

background layer by selecting Layer>Create Clipping Mask. Use the RGB channel to adjust 

images even more when you get to colour grading.

Use the render flame filter
combine the render fl ame fi lter with a real fi re image and sparks

Pay attention 

to even the 

smallest of 

details. Even if 

no-one else 

notices, you 

will sleep 

better 

knowing you 

put everything 

you had into 

your work!

Having a vision is 

crucial in executing 

a well-balanced 

image. Having a 

plan will keep you 

organised and on 

track to creating 

something special

Making sure the colour temperature 

and exposure match between your 

subject and background is crucial to 

creating a believable image
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Create sparks To create sparks you will reverse 

the process a little. Create a new layer and grab a Hard 

Round brush set at 8 pixels. Start drawing very small dots and 

dashes about the size of sparks. Use the Magic Wand tool to 

select the negative space of the layer then inverse the selection. 

Next go to your Paths panel then click the Make Work Path from 

Selection icon. Follow the procedure from Step 10 and make 

sure to change your blending mode to Screen. Add a Motion 

Blur to give the sparks some motion.

12

Although 

the layer you want it to be over and turn the blending mode to 

Screen. On you keyboard hold down Cmd/Ctrl+T. This will allow 

add fog and smoke. A great smoke and fog package can be 

bought at www.phlearn.com. Use a Levels adjustment layer to 

adjust the amount of fog or smoke.

13

Add a blank layer above your subject. 

Grab a Soft brush, change the Opacity to around 20% and make it orange. Take your brush 

your model layer so it only affects that. Turn your blending mode to Color. Use the procedure from 

Step 9 to make it only affect the highlights. Add a layer mask and mask out any areas that shouldn’t 

14
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Sometimes techniques like Render 
Flame are hard to grasp in written 
form. A video or visual explanation 
can sometimes help. Brendon 
Cawood has created a video tutorial 
to go along with the Render Flame 

by going to his website www.
brandoncawood.com and clicking 
on the video tutorials page. You will 

elements as well as colour grading.

Visual help

Save it You can save the image several different ways depending on its use. If you are going to use a 

as a JPEG or TIFF. If you are planning on using a low-end printer or saving for online use you want to convert to 

good to scale it down before saving. Select File>Automate>Fit Image. Do a width of 2048 pixels and a height of 

18

Final colour grading First add a Channel Mixer 

white. You want to use this adjustment for some desaturation 

so bring the Opacity down to 15%. Next add a Color Balance 

adjustment layer. The Color Balance adjustments will vary from 

want. For this image the Shadows and Midtones were pushed 

towards the cyan and blue tones, while the Highlights were 

pushed towards the red and yellow tones.

15

16

17

Sharpen Save your PSD. Once you 

have saved it select Layer>Flatten 

image by pressing Cmd/Ctrl+J. Select 

your top layer. Next select Filter>Sharpen> 

it. You can also use the opacity to pull down the 

sharpening over the entire image.

Add grain Lastly add grain. Create a new layer above your sharpened image. Hold 

amount you use. Choose Uniform and leave Monochromatic unselected. Once you apply, hold 

down Cmd/Ctrl+U. Then pull down the Saturation to -85%. Leaving a little colour in the grain will 

“Leaving a little colour in 
the grain will make it 
look more natural. Make 
sure to do this step at full 
zoom. You can adjust the 
opacity if it feels like it’s 
too much”
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Learn how to design and paint a sultry steampunk sky captain 
using layers, textures and selections

Make your own 
steampunk 
sky captain

Ladies and gentlemen, boys and girls – it’s time to 

go retro! In this tutorial, we’ll venture into the beguiling 

world of steampunk, where the technology of the 1800s 

is all you need to achieve the greatest and most imaginative 

genre and learn how to use them in a fresh way, as this tutorial 

discover how to use a semi-realistic painting style to give your 

As with any illustration, your draftsmanship skills will come in 

From sketch to colour flats
Build up the base of your illustration before tackling the details

that a graphics tablet can give you is essential to 

It is Photoshop’s highly effective painting tools 

and precise blending modes that can be fully 

relied on for this sort of illustration, as they will 

simple tutorial will direct the use of layers and 

brush passes to build up the character, adding 

texture with clipping masks where necessary 

Create thumbnails Before beginning 

any new illustration, it’s helpful to sketch out 

thumbnail size, for example – is a great way to force 

yourself to think only about the big picture without 

generate a lot of different ideas quickly and have 

Draw ideas into frames Create a 

series of boxes with proportions to match 

layer, sketch up a different idea in each box – would 

a low-angled three-quarter view work? Perhaps a 

confrontational close-up? Consider which angle 

background is an important part of the scene and if 

Build character and composition 
You can’t talk about composition without 

steampunk femme fatale as a pistol-packing, 

costuming elements and accessories at this point, 

as large objects will affect the overall portrayal of the 

01
02 03

David 
Nakayama
www davidnakaya-

Artist

San Francisco-based 
illustrator and concept 

a freelancer for Marvel 

working in both digitally 
painted and comic-

Photoshop
Software
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Reformat your image At this stage, 

look for feedback on your image. For this 

didn’t feel suitable). We also thought the image could 

be overworked a bit more. First, paste the lines of the 

selected thumbnail into a new document and scale 

it all up to full size (A4 at 300dpi) using Transform 

(Cmd/Ctrl+T). Then use the Crop tool to expand 

your canvas size. Fill in what’s missing on the edges.  

 Now it’s time to really 

dig into the design, and for many artists, it’s 

more intuitive to work with lines. Lower the Opacity 

of the layout layer and create a new layer (Cmd/

Ctrl+Shift+N) for the line art. Every draft costume 

checklist of familiar props – things like goggles, 

brass, rivets, gauges and gears.

Mix it up Don’t stop there. Relying only 

on typical design choices will result in an 

uninspired and unoriginal piece. To keep things 

fresh, make sure to include elements that are a little 

outside the box. Adding a few tabs to the muzzle of 

the revolver evokes the look of a key, which feels right 

for the genre. Tattoos aren’t typical in steampunk, but 

the one on her forearm combines an old-fashioned 

diving helmet with kraken tentacles – both well-

known symbols in this aesthetic. Later we’ll remix 

with the palette in a similar way. 

Prepare for colour The goal is to make 

the transition from black and white to fully 

painted colour. To begin the process, soften the hard 

blacks by tinting the line art. Lines describing skin 

become red-orange, for example, whereas leather 

elements are made dark brown, while white elements 

use a dark grey. Simply select the Lines layer, choose 

the Lock Transparent Pixels option at the top of the 

palette and then paint in the lighter colour. Leave the 

lines of the eyes, eyebrows and lips black so that they 

stand out, helping to draw the viewer’s eye.

Ctrl+Opt/Alt and clicking the line dividing the two layers, attach an additional layer for each main colour in the 

needed to divide up the form and makes it much easier to reselect any particular area of colour later. 

04

05 06

07

08

Crop to expand
It sounds counterintuitive, but did you know 
that the Crop tool is the ideal way to expand 
your canvas? Select the whole image area 
with Crop, then instead of pulling them 
inwards, drag the corner handles out to the 
desired larger size. Hit return to see your 
revised canvas size.
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Develop shadow and tint  With the 

general lighting source established, add an 

overarching shadow treatment to complement it. 

Create two new layers at the top of your stack. In the 

of medium saturation – purple, in this case. Switch 

the second layer to Hard Light mode and use a soft 

round brush with the swatch colour to tint any part 

away the character will seem more complete, while 

bringing together the various colour groupings into a 

Find the light source The beauty 

of this approach is that it’s easy to perform 

selections. The paintover exists on a separate layer 

too, which makes it easy to turn on and off. Doing 

this enables you to see if it’s adding or detracting 

from the merged working copy. In order to choose 

what to put in your paintover layer, it’s a good idea to 

let a single light source be your guide. In this case, 

the light is high and a little left of centre on the face, 

which is not consistent with the character’s chest. 

Thankfully this can be adjusted.

Don’t forget the context 
progresses, it’s important not to lose sight 

of the overall image. Consider things like the 

colours and if they are working, or if the anatomy 

and foreshortening make sense in the image. To 

helps to have a duplicate window open on a second 

New>Window to do this. Once again, get some 

feedback. In this example, more overwork is needed 

clothing, which adds an unexpectedly nice touch.

Set up your layers Highlight the master 

and individual colour layers and create a 

merged copy of them (Cmd/Ctrl+Shift+E), labelling 

this layer Flats. Next, merge the Flats and Lines 

layers together to create a copy of your complete 

use the Magic Wand tool to easily recall a colour 

grouping from the Flats layer. Hide the selection 

using Cmd/Ctrl+H if it’s distracting. Then in the 

Paintover layer, brush in darker and lighter tones, 

Add Colour and shading 

Begin painting
Start fl eshing out your image by building on the colour fl ats

09

“This makes the fi gure feel 
more fi nished almost right 
away, adds interest and 
brings together the various 
colour groupings into a 
unifi ed whole ”

10

11
12 13

Establishing a 
strong composition, 

a pose that 
communicates 

character and 
eye-catching 

costume design are 
generally the fi rst 

priorities in any 
illustration

With design considerations 
completed in black and 

white, adding colour is the 
second job, beginning with 

line tints and fl at-colour fi lls

The majority of 
time spent on this 
piece will go into 
lighting and 
texture passes 
that ultimately 
give this 
character 
dimension and 
a realistic 
appearance

As painting 
begins, it’s 
important to keep 
an eye on the 
overall image and 
ensure that the 
fi gure contrasts 
strongly with the 
background, as 
if it leaps off 
the screen

Fantasy Art Genius Guide  97

Genius Guide
Fantasy Art



Detail the character
Conclude your piece with detailed rendering

Control the focus Rendering every part Build texture 

www.cgtextures.com

Work with textures 

Collect reference photos
The more realistic your painted style, the more you’ll need to collect reference. It’s almost 
impossible to paint detailed realism from memory alone, so spend the time to gather images 

14 15 16

17

18

Gather 
texture assets
A little more on the topic of texture 

www.
or 

textures
handy assets for your texture library. In 
general, try to download the largest 

reduce the amount of Clone Stamping 

materials with brushes are readily 

w  is another great 

“Now the fun part – it’s fi nally time to add the bells and 
whistles to make this image sing … Finally, it wouldn’t be 
steampunk without some steam! Add a few puffs around 
the fi gure’s brass backpack using a cloud texture brush”
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Secrets of steampunk
Find out about the visual language of steampunk and how it is created

Victorian materials 

are key to 

steampunk. Brass is 

a particular 

favourite. Its opulent 

golden colour adds 

richness to 

illustrations that 

are often in a 

limited palette… any 

object rendered in 

brass look instantly 

19th Century

These are not merely hot 
air balloons or zeppelins 

though – they’re ships 
built along classic 

Victorian lines that have 
been enhanced with Jules 

Verne-inspired sci-fi  
technology. Adding them 
into your piece is a quick 

and obvious shorthand 
for steampunk

Steampunk can be 
produced in any art style, 

the most common is 
realistically rendered 
digital paintings that 

emulate the oil paintings. 
Don’t feel limited by 

this though. As long as 
you’re hitting other 

steampunk signifi ers, you 
can introduce more 

modern elements
Don’t get bogged down 

by obvious steampunk 

symbols like clockwork. 

This character’s tattoo 

isn’t typical of 

steampunk in itself, but 

the mix of the old-

fashioned diving helmet 

and oversized octopus in 

the design clearly 

references classic 

Victorian sci-fi , like 

Twenty Thousand 
Leagues Under The Sea

Advances in Victorian 
technology meant that 
those who travelled in 

new inventions like cars 
often needed to protect 

their eyes from wind and 
dust. Steampunk’s love of 

reimagining Victorian 
technology as more 
powerful and more 

advanced than it actually 
was means that goggles 

have become a must-have 
accessory for any 

steampunk character

Steampunk 

clothing takes 

inspiration 

from both 

Victorian 

fashion and 

more practical 

clothing from 

the time, such 

as army 

uniforms or 

stereotypical 

ensembles like 

the classic 

explorer outfi t 

of pith helmets 

and puttees. 

Zips and 

poppers are 

out, but rivets 

and carabiners 

are in! 
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When working on composite images, 

other. As you continue to manipulate the layers and 

looked good before may not match the evolution of 

The success of a composite image relies on the 

artist’s ability to make changes and tweaks 

lighting effects, rather than a blank layer with a 

modes, you will also have additional sliders and 

layers, without the need to create more layers and 

great way to enhance your images within a non-
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standard retouching techniques with creative ones

 

01

02

Photoshop CC 
now supports 
linked Smart 
Objects. This 
means you can 
work on a full 
size image in 
great detail. 
After saving, 
you can link it 
to another 
document at 
whatever size 
you want, 
without the 
need to double 
or triple the size 

composite 
while working 
on it.

Go 
smart

Retouch a fantasy 
sorceress

 
 

Artist

Ross specialises in 
portrait and composite 

worked in advertising 
and editorial for 20 years, 
and lives and works in 

Source Files

Software

that have been made for 

John Ross

com

Retouch the model
Start with basics like cloning, colour and tonal changes
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Another Smart Object Select all the 

layers and Convert to Smart Object. Name it 

‘Retouched Model Bottom’, and change the Opacity 

to 95%. To make changes to the model later, you can 

go back to this base image by double-clicking the 

Smart Object layer. This layer will contain all of the 

corrections you have made to the model. If you want 

to change it later, just double-click again, and a new 

window will open. Make your changes and then save the 

adjusted image.

04

Begin compositing Create a layer mask for the model’s Smart Object layer and loosely cut 

http://tinyurl.

com/lxya5t8

before to make the colour and tonal changes. Place all these visible layers into a folder called ‘Back’.

05

Place the disk Open the image ‘Disk.psd’ 

drop the Disk layer containing the shape underneath the 

layer into position behind the model’s body. Use Opt/

Alt while clicking on the Disk layer to create a selection 

of the shape, and then click the Add Layer Mask icon at 

bottom of the Layers panel. Change the blending mode 

of the Disk layer to Screen. This will give a mask of the 

intricate shape.

06

Prepare the model Create a new blank layer for your cloning and touch-up. Smooth out 

the Healing Brush, while others may prefer Dodge and Burn. You will make many adjustments later, but 

By using the 
Brush panel’s 
Shape 
Dynamics, you 
can adjust the 
Size Jitter, Fade 
Jitter, and 
Roundness 
Jitter. When you 
paint with the 
brush now, it 
will randomly 
change many 
of your brush 
settings as you 
paint. There’s 
also Scattering, 
Texture, and 
Wet Edges, as 
some of the 
many options 
available.

Use 
shape
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Add the disk’s layer effects Select all the pixels on 

the Disk layer and delete them. All you want is the shape as 

a mask – the pixels will not matter. Use the FX icon at the bottom of 

the Layers panel and enable Outer Glow with settings of Screen, 

75% Opacity, Size 56%, and pick a blue colour. Next, enable Drop 

Shadow with a black colour set to 75% Opacity, Distance of 10, and 

Size of 5. All the other settings can remain as defaults. Click OK.

07
08

Add texture Above the Back folder, create a new folder called ‘Texture’. Inside, place a textured 

image layer of your choice like tinyurl.com/mrgl6fv from deviantART and cover it over the whole 

image. Drop the Opacity down to 15% with a blend mode of Difference. This begins to add a painterly effect. 

Add a layer mask, and paint black to remove the effect from the top half of the image, where you want to retain 

the details. White will be on the bottom, revealing the texture effect.

09

Duplicate the model Select the 

Retouched Model Bottom layer, and drag 

it onto the New Blank Layer icon. This will create a 

second model layer, but still reference the same 

embedded Smart Object. So if you want to alter one 

Smart Object, it will apply the same change to the 

other layer. Place it above the Texture folder. Name it 

‘Retouched Model Top’, with 100% Opacity. Paint on 

the layer mask to erase the lower half of the layer. This 

will make more sense in the next step.

10

Add the disk’s glow  From the disk centre, use the Elliptical Marquee while holding 

down the Shift key. Select a Curves adjustment layer. Move the curve up, and set to 

Luminosity blend mode. This goes above the Back folder. Name it ‘Disk Glow’. Use Layer FX 

to select Outer Glow, Precise, and Size of 81, with the rest default. Place Disk Glow into a new 

group folder called ‘Disk Glow Cutout’. Add a white layer mask to the group, using a black brush 

to stop the glow from crossing over the model’s legs.

Refine the model and lighting
Add texture, lighting and layer blending
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Begin the blending Now that you can begin to see 

masks for the two model layers. For the bottom model layer, you 

should keep the body tight and let the gravel at the bottom fade 

up into the sky. Mask the loose hair, and let the wispy parts blow 

around. For the top layer, keep the parts you want the natural 

colour and erase away, starting at the chest. You can continue to 

clean these masks up later, as needed.

12

Add a gradient map Above the Texture layer, add 

a Gradient Map adjustment layer. Click on the gradient’s 

to choose from. For now, choose Photographic Toning. Cycle 

be nice. On the layer mask, paint away the top half of the image 

with a black brush. Blend it in so that while a different colour, the 

bottom gradient merges with the top area seamlessly.

13

Add texture light Above the Texture layer, add a Curves layer if you want to lighten up 

the image. With all these layers being added, the image starts to get too dark. This should 

really start adding depth to the image, now that you have had a chance to play with the tonal range. 

Remember, you want to see the details of the texture in the lower areas of the frame, as well as 

ensure that the upper body remains the focal point of the image.

14

Add glow and star bursts Under the Retouched Model Top layer, create a new 

Curves adjustment layer. Pull up on the middle of the curve to lighten over the image. Fill the 

mask with black to hide the effect, then use a white brush to paint in a glow under the Top Model with 

various brushes of different sizes and shapes. Create multiple Curves layers, with different settings, 

www.deviantart.

com/morelikethis/99002450.
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When retouching, direct the viewer’s eye to where 
you want them to go. Bring the focus to the most 
important areas. Warm colours come forward, cool 
colours go backwards… bright tone comes forward, 
dark tone goes backward. With these simple 
principles, you can guide the viewer through the 
image. In a portrait, the face should be the brightest 
and warmest. By creating darker barriers around 
the sides and lower part of the image, you can often 
hold the viewer’s attention much longer. The darker 
and cooler areas do not need to be severe; even 
subtle shifts can lead to favourable results.

Focus on the 
focal point

Add paint splatter Make a new Curves adjustment layer on top of everything. Bring 

mouritsada-stock.deviantart.com/art/Brush-Pack-Splashes-Of-

Paint-94180220, you can add splashes of paint around the image. For variety, adjust the Opacity 

of the layer, or arc of the curve. You can use one Curves adjustment layer, or several with different 

settings. Also try some Layer FX like Outer Glow for added realism.

18

Add texture shadows 
make a Curves adjustment layer. Bring the curve down 

of the image. Focus it on the left and right sides, as well as over 

15

16

17

Add geometric shapes By using image 

166758839 from Shutterstock or similar, you can add 

geometric patterns to the lower half of the image, off in the 

apply any changes with the Curves tool. Instead, use Layer FX 

Duplicate geometric shapes Select the Curves layer with the geometric shapes 

on it, and use Cmd/Ctrl+J to duplicate the layer. On the lower version, go into the Layer FX 

“To match the glow of the circular 
shape behind the model, add your 
own halo around these new 
geometric shapes”
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Damon Woods
www.dkwoods.
com

Artist

My name is Damon ‘DK’ 
Woods and I make 
next-gen game 
characters. Currently, I’m 
a professional character 
artist in the videogame 
and VFX industry. I’m 
also currently a character 
art instructor at the 
CGMA Academy.

ZBrush, 3ds Max, 
Marvelous Designer, 
Photoshop, KeyShot 5

Source Files

Software

Download all the 

need from FileSilo.

Character

“The skin-tight 
accessories were 
created by 
masking out the 
shape of the 
clothing on the 
body and then 
using extraction”
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Today, we’re going to learn how to 

create a rebellious cyberpunk 

teenager from the not-so-distant 

future. The inspiration for this character came 

to the next level.
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Work your way outwards
Create the skin tight accessories fi rst

Render a cyberpunk 
character

01

02

Concept
The fi rst step as part of any workfl ow is having a concept. 
I start by sketching out my character, making sure that 
the details and forms are clear. This saves a lot of time 
down the road.

Start at the basics  In building up a character, it’s ef ective to start at the most skin-tight items and 

work your way outwards. This helps us build a well-fi tting outfi t and helps reduce geopenetration 

issues down the road. The skin-tight accessories were created by masking out the shape of the clothing on 

the body and then using extraction. The skirt and glasses were created in 3ds Max.

Shape the shoes  Trainers, like most 

footwear, are simply a compilation of fl at 

leather shapes. To make the shoes, use a 

DynaMeshed sphere and shape it around the foot. 

Then subdivide it a few times and create the 

dif erent leather patches that make up the pattern 

of the shoe using the same mask and extract 

method as Step 1. Feel free to use your real-life 

trainers as reference.
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“A talented artist could probably sculpt some 
pretty believable folds, but they will never be 
able to match the speed and accuracy that a 
cloth sim program can provide”

Use sim to create cloth 
We want the jacket to have 

some nice realistic folds on the 

jacket’s sleeves. 

A talented artist could probably 

sculpt some pretty believable folds, 

but they will never be able to match 

the speed and accuracy that a cloth 

sim program can provide. Using 

Marvelous Designer, we can create 

this jacket with a few well-placed 

shapes. At this point, you don’t need 

to nail every single wrinkle. We just 

need a good foundation to start on. 

When you’re all done, make sure to 

set your particle distance down to 

around 3. Then, export as an OBJ to 

bring back into ZBrush.

Touch up the cloth  Now that you have a 

solid base to work on from Marvelous 

Designer, go in and add the smaller wrinkles and 

irregularities to the mesh that we see in everyday life. 

Once again reference is key. Pay close attention to the 

way the cloth buckles and ripples around seam lines. 

Pay attention to the natural direction that the sim 

cloth fl ows and add additional folds in places that 

look a bit bare. The collar, straps and other pieces 

were created with the CurveStrapSnap brush and 

touched up in 3ds Max.

Add seams and stitches  To add stitches, create a custom Curve brush with a 

simple piece of geo to repeat. Making sure that Curves mode is on, start adding your 

stitches to the areas around the edges of your clothing and anywhere that patches are 

joined. As an additional detail, use the Dam_Standard brush to slightly indent the path of 

the stitches. To create the seams on the jacket, use the CurveStrapSnap brush.

Add nuts and 
bolts To add the nuts 

and bolts that give our 

character a better sci-fi  feel, 

we will use the IMM (Insert 

Multi Mesh) Brushes. Select 

the IMM_ModelKit brush 

and then hit M on your 

keyboard. This will pull up 

all of the various shapes and 

objects for you to choose 

from. To add the shape, 

simple click and drag on 

the object.

03

04

05

06
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When starting a project, pay attention to the real-world scale of your 
character. In 3ds Max or Maya, use the measuring tools to make sure 
your character is a realistic height. Programs like Marvelous Designer 
and KeyShot use real-world scale to calculate things like gravity and 
thickness. If your character is 70 feet tall or the size of an ant, it will have 

Size matters
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Facial details  Adding details to the face needs to be very precise. 

Make sure you have plenty of reference that matches the type of 

character that we want to convey. Sculpt what you see and not what you 

know. Reference is key in creating a believable piece. In this case, our 

character is high school age with attractive features. Alpha 07, with Spray 

mode on and at an intensity of around 6, is ideal for adding skin pores. Pay 

close attention to your reference to see what size, direction, and depth the 

pores are going in. Use Alpha 58 with Stroke mode on to create the subtle 

lines under the eyes and on the lips. 

Create the patches  Our hero is an accomplished athlete and she’s not 

shy about it. To adorn her with her various patches, we fi rst created some 

custom Alphas in Photoshop. Then we import them into the Alpha palette and do a 

mask extract like before. These meshes can get pretty heavy, so we suggest hitting 

them with ZRemesher.

Create hair  To create the curly ‘frohawk’, simply mask the area along the top of her head and go to the 

Fibers tab in Lightbox. Select Curley_Hair1.ZFP. From there, go into the FiberMesh tab and hit Preview. 

From here, you can adjust all of the parameters of the hair. You can see the settings that were used for this piece. 

Once you’re satisfi ed, hit Accept. The eyebrows were created the same way. Just mask of  the eyebrow shape, 

use a straighter hairstyle like Fibers160.ZFP and lower the length and fi bre count accordingly.

Add the braids  The braids were 

created using a custom Curve brush 

graciously donated to the ZBrush community 

by Tetsuo Oshima. Draw the braids across the 

head one at a time and adjust with the Move 

brush. By nature, the Curve brush will add the 

braids to the same SubTool that you are 

drawing on. A quick way to separate them is to 

clear your masks, then Cmd/Ctrl+Shift+click 

the head to isolate it. Mask the head 

completely and then Cmd/Ctrl+Shift+click in a 

blank space to unhide everything. Now with 

the head masked of  from the braids go to 

Subtool>Split>Split Masked Points.

07 08

10

09
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Block it all in  Just like in the 

modelling phase, we fi rst want 

to block in all of the colours with fl at 

colours. To do a fi ll, go to the Color tab 

at the top of your screen and hit 

FillObject. Make sure that Mrgb is 

selected and use a basic material for 

now. The school colours for her are 

green, black and gold. Using lots of 

reference of athletic apparel, we can 

get a feel for how to approach things. 

The goal is to make her outfi t read as 

a high school uniform, no matter what 

time period it is set in. The clothes 

would be clean, colorful and well 

maintained with dif erent types of 

materials mixed in.

Texture the skin  Using the same skin 

colour that we used as the fi ll, select Alpha 

7 with Spray mode turned on. Make sure to turn 

of  Zadd and Zsub so you aren’t sculpting while 

you paint. Now lightly brush across the surface to 

add some irregularity to her skin tone. You can 

also go back in and add smaller things like 

birthmarks and acne scars. Remember, nobody is 

perfect and small skin irregularities really help add 

realism to skin texture. To add the tattoos, images 

were turned into Alphas and added with Drag 

mode. Use a dark green colour instead of pure 

black to give the tattoos a more realistic tone.

“Remember, nobody 
is perfect and small 
skin irregularities 
really help add 
realism to skin 
texture. Add 
birthmarks and 
acne scars”

Everyone has eyelashes, but not every 
artist remembers to add them. The Curve 
brush can be used to quickly and 
effectively create eyelashes. First model 
out a single lash and then orient the 
camera so that you are looking at it from 
the tip. Go into the brushes palette and 
select ‘Create Insert Mesh’. Turn on 
Curves mode and draw along the edge of 
the eyelid. Keep in mind that the upper 
eyelashes are fuller than the bottom ones.

Add eyelashes

11

12
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“Go through 
and assign 
materials to all 
of the different 
pieces to help 
add another 
level of detail”

Assign materials 

Now go through 

and assign materials to all 

of the dif erent pieces to 

help add another level of 

detail. With M selected, 

select dif erent materials 

from your Materials 

palette. To do this, select 

the SubTool and do a fi ll the 

same way we added the 

colour. ZMetal was used 

for things like nuts, bolts 

and zippers. Skin shader 4 

was used for skin. Basic 

material was used for cloth. 

Export the geo into 
KeyShot  We’ll be 

using KeyShot 5 to do our 

rendering. The ZBrush Bridge in 

4R7 lets us zap our model and 

materials right over to KeyShot 

with the click of a button. Just 

go to Render>External 

Renderer and hit the KeyShot 

button. Now when you hit the 

BPR button it will automatically 

launch KeyShot and send over 

all visible geo.

Get to know Damon 
Woods’ characters

Indi Girl
ZBrush, 3ds Max, V-Ray (2011) 

 A female bust that I did a while back. 

The Girl 
. 

Mr Liu
ZBrush, (2012) 

 

Late Night Bite
 ZBrush, KeyShot, (2014) 

 

Adding text and labels is a 
great way to add another 
level of detail. In modern 
times, almost everything 
comes with instructions. 
We’re so used to seeing 
labels and logos on things 
that we don’t even notice 
them until they’re gone. 
Create some interesting 
logos and labels and 
place them thoughtfully 
throughout your piece. 
Even something as simple 
as a serial number can 
add that extra graphical 
punch to your artwork.

What’s 
in a label?

13

14
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“The mixing of various 
genres is a great way to 
explore new avenues and 
possibilities for design”

Are the HDRI scenes not cutting it for you? Take matters into your own hands and add some 
lights of your own. Go to Environment>Edit HDRI and then click the Pins tab. Click the Add 
Pins button and a circle will appear on the HDRI map indicating the position of the new light. 
You move the light around by clicking and dragging it and changing parameters such as 

lighting like a pro!

Add lights

Final render settings  Once 

you’re happy with the way your 

materials are looking in the scene, fi nd a 

good camera angle and save that 

camera by going to Camera>Add 

camera. Then click the Camera tab on 

the right. Here you can make 

adjustments to things like focal length, 

FOV and even add lens ef ects like depth 

of fi eld or bloom. Once you’ve fi nalised 

your camera, hit Cmd/Ctrl+P or navigate 

to the Render tab. For best results, we 

recommend setting the samples to at 

least 32 and choosing a fi le type that 

supports Alpha. Click the box that says 

Include Alpha, set the fi le size and 

destination to your liking and hit the 

Render button. Congrats, you’re done!

Adjust materials  Once you’ve created a lighting setup that you like, we can adjust our materials in 

the scene. KeyShot will automatically assign materials based on what you assigned in ZBrush. But 

some of these materials may not be what you want. To assign a dif erent material, click the Materials tab 

under Library on the left. Here, you can choose from the huge selection of materials that KeyShot has. 

Simply drag and drop the material over the piece of geo to assign it. To preserve your textures, hold Opt/Alt 

while you do this. The materials also have a great selection of normal and transparency maps. We used the 

dots textures to create the mesh materials by going to the Textures tab, clicking the bump and opacity 

boxes, clicking the dropdown next to Texture type and selecting Texture map. Then select the Dots map for 

the bump and opacity.

Set up lights  When you have all of your 

geo exported to KeyShot, you will always be 

placed in the default studio scene. The fi rst thing 

you might notice is that the lighting looks really fl at 

and uninteresting. Let’s change that by setting up a 

scene of our own. Go into Environments under the 

Library tab on the left and select an HDRI scene that 

you like. For this tutorial, we used the 

Outdoor>ForestRoad scene. Now go into 

Environment under the Project tab. Click Edit HDRI 

and from here you can make several adjustments to 

your piece like Saturation, Hue, Brightness and 

Contrast. To adjust the light direction, just use the 

rotation wheel. You can hide the background image 

by clicking the Color box under Background and 

choosing a less distracting neutral colour.

15

16

17
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In this tutorial we will be covering the 

crucial steps in the modelling and 

texturing stages for creating a digital 

character, as well as a brief overlook of lighting 

and rendering.

Design an 
Elven archerAaron Hunwick

Artist

Source Files

Software

Create a 
reference sheet 

 Block out the anatomy  

01

02 03
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“Using Polypaint to 
determine areas of 
higher density like 
the head, we can get 
a good result quickly 
with very little effort”

Concept
I based this piece on the Dark Elves of the 
Warhammer universe. These mystical 
fantasy creatures are rich in character and 
have a distinct style from any other Elves.

Genius Guide
Fantasy Art

Fantasy Art Genius Guide  115



116  Fantasy Art Genius Guide

Character

04

07

08

05

06

With access to automated software such as 
ZRemesher we often forget the importance of 
having complete control over our topology. Often 

ensure we get the most out of our geometry. 
TopoGun offers us full control so that we are able 

loops, which is especially useful for modifying our 
facial topology. Areas such as the eyes, mouth 
and nose will need extra attention and often more 
edge loops than the rest of the face. This is 
because they will need more polygon density to 
be able to deform correctly.

The power of 
TopoGun

Block out armour design In ZBrush, mask 

out the area on your character where the armour will 

sit. Then extract a new ZTool, convert to DynaMesh and use 

this as a base to build out from. Slowly increase the resolution 

while focusing on the form and silhouette, this will ensure you 

don’t get tied up in the details. It’s good practice to block out 

all of your armour pieces before moving on to the next step, 

this way you can be sure that your shape language is clear 

and all your amour pieces are working well together.

Create new topology 

topology. Using Decimation Master in ZBrush we can export our blocked-out armour piece 

into TopoGun and build our base mesh. Then using Maya we will utilise hard-surface modelling 

are modelling. For armour, having a very sharp edge is not always preferable. It’s important to look at 

real-world reference as it helps ground your model in reality even if it’s from a fantasy world.

Detail the armour We now need to 

bring our meshes back into ZBrush for a 

detail pass. Ensure that you smartly group similar 

material types together to make texturing and 

shading easier later on. You want to start by laying 

down some breakup on the surface, for example 

using the Clay brush with Spray mode and a 

gradient Alpha. Then using the Move brush subtly, 

adjust areas of the model, paying special attention 

to breaking up the silhouette. Then move to focus 

on dents and smaller scratches to add even more 

of material you are mimicking.

Pose with Transpose Master Because we 

pose we can now use Transpose Master to pose our model. 

Make sure you have plenty of anatomy references related 

to the pose you’re trying to achieve – female-anatomy-for-

artist.com is a very good resource for this. If you have armour 

that sits over a deformed area such as an elbow or knee, you 

may want to hide it before using Transpose Master, and then 

move it into the correct position after completion of the pose.

Create hair using FiberMesh When you are working with long hair it’s critical to be 

able to isolate and work with small clumps one at a time. Before you generate the FiberMesh, 

Brush>Auto Masking>Mask By Polygroups to ensure you’re only manipulating one Polygroup at a 

time. Use the GroomHairBall brush to clump your hair together. Then use the Groom brushes to style 

the hair to your liking.
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The theory behind sculpting in ZBrush is to block 
out your main forms on a low subdivision level, 
doing this at a high level will make it harder to create 
realistic forms, especially with organic sculpting. 
Slowly work your way up the levels adding detail. 
Consider how the surface would have been created, 
back in medieval times there would have been no 
way to perfectly make a piece of armour and your 

adding a detail pass – when you complete it you will 
have control over its strength and can easily mask 
out areas that don’t work.

Tips for sculpting in 
ZBrush

Simulate the cloth Marvelous Designer is 

a fantastic program to use for simulating cloth. 

The advantage of waiting until the model is posed for the 

cloth simulation is that you don’t have to mess around with 

resymming. One useful technique is to use pinning to keep the 

when you are blocking out your shape and positioning to use a 

high-particle distance to keep things running fast. Once that’s 

level of detail.

Set up 
shaders This 

step can take quite a while; 

tweaking shaders so you 

have the correct values is 

very important and often 

overlooked. Start with 

the specular and gloss 

values and then add in 

your diffuse colour. It’s 

very useful to have these 

dialled in before you start 

work on your map painting 

because once you have 

multiple maps plugged 

individual effect of each 

map. Be sure to check your 

good photo reference or 

even real-world reference 

is crucial to mimicking the 

material in 3D.

Make UVs There are many techniques that can be used 

for this step. UV Master in ZBrush is a great automation tool 

to get you started and for this project. It’s perfect for most meshes 

because we will be projection painting in Mudbox where a perfect 

This software has very powerful real-time unwrapping that enables 

you to quickly cut and unwrap any surface with ease. It also has 

particularly useful colour coding for how much UV space the faces 

are taking up: red for too little and blue for too much.

decoration on Dark Elves. These were simply modelled in Maya then exported to ZBrush for a 

break up the edge of the fabric so just mask by edge and generate them from that.

“This software has real-time 
unwrapping that enables you to 
quickly cut and unwrap any surface 
with ease. It also has particularly 
useful colour coding for how much 
UV space the faces are taking up: red 
for too little and blue for too much”
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Create seamless textures Now it’s time to take our model into Mudbox and 

use projection mapping to create some realistic textures. Mudbox is great because 

it uses a similar layer and painting system to Photoshop, and you can easily move your map 

between the two programs. To get your mesh from ZBrush to Mudbox there are multiple 

methods, but using Decimation Master is the best because you are able to retain a lot of 

detail while painting in a reasonably low-resolution mesh. Make sure you check the Keep UVs 

option and decimate to around three to ten per cent of your high-resolution mesh.

Set up lighting 

For this character we 

are going to use V-Ray for 

rendering. Often when lighting 

a character a simplistic 

three-point light setup is all 

you need, and this consists 

When positioning the lights 

make sure you work with one 

light at a time so you know 

exactly how it’s illuminating 

your model. Once you have 

completed your light setup, 

insert a dome light with an 

HDRI map at a very low 

intensity. Try to align your key 

light if your HDRI has a strong 

light source like a sun. 

Postproduction work Render out a 16-bit EXR image 

to ensure you get the maximum control in postproduction. 

This is because 16-bit images have more light information and can be 

adjusted in Photoshop without loss of quality. Other useful passes are 

is very useful for colour correction of your raw image. Finally adding 

some grain, chromatic aberration and other very subtle overlays can 

add that extra touch of realism to your piece.

Rendering techniques The shader, texturing and 

be making tweaks to all of these while in the test render phase. It’s 

important to have good settings for a fast test render and high-quality 

production render. There is a very good resource on YouTube by 

Andrew Weidenhammer based on a paper by Robert Nederhorst 

explaining in detail how to set up your V-Ray settings. To speed up your 

render with Render Settings>Preset>Save Settings as Preset.

13
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Using the Multi Map Exporter you can easily bake maps that will assist in the 
creation of textures. We will need Displacement and Normal maps to get our 
mesh rendering accurately in V-Ray. The Ambient Occlusion and Cavity 
maps are useful to multiply or overlay on your textures. You can also 
desaturate your Normal map and run a high pass in Photoshop to add 
some extra detail into your diffuse and specular textures. A similar technique 
can be used if you bring in your Displacement map, adjust the levels and 
then use an overlay at a very low opacity. Just remember subtlety is the key.

Baking maps from ZBrush
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Learn how to create an epic videogame 
key art to capture your audience

Fashion pro 
key art

The entertainment industry 

relies on the use of 

powerful imagery that can 

touch an audience emotionally, 

and create memorable campaigns 

 

Whether iconic, cryptic or a mixture of 

both, key art pieces and posters have 

the sole purpose of making a bold 

statement to immediately connect with 

fans across the globe. 

Therefore, a good key art is 

fundamental for a successful 

campaign, and in some cases, it can 

determine how well or poorly a 

franchise will perform. Massive, slick, 

iconic, epic – these are all words that 

should be kept in mind when creating 

key art, artwork that has the universal 

ability of telling a story in an instant 

and grabbing the viewer’s attention 

with a single glance.

Over the next few pages you will 

get an exclusive behind the scenes 

look at how we created the Goleador 

League key art. This piece is a fantasy 

soccer-themed mobile game that our 

studio recently launched for Italian 

confectionery manufacturer, Perfetti 

Van Melle.

From the integration of 3D elements 

with 2D layer compositing, to creating 

a digital matte painting backdrop, this 

tutorial will guide you through the 

steps needed to create a real world 

videogame key art.
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the lead CG artist at 
Saizen Media. He has 

videogame projects, key 
art and illustration.



CREATE PRO KEY ART

Adding Rim Lights  Use the normal CG 

layer as an illumination layer. Desaturate it by 

selecting Hue/Saturation from the adjustment menu. 

Next, with the layer still selected, press Cmd/Ctrl+I to 

invert it. Select Gamma Curves (Cmd/Ctrl+M), and 

adjust the curve until you get a black image with a glow 

around the border. Go to Color Balance (Cmd/Ctrl+B) 

and tint the layer with Cyan and Blue. Then double click 

on the layer and set the blend mode to Screen. This will 

create a blue rim around your character to simulate the 

moonlight. Use the Eraser tool to eliminate areas that 

aren’t lit.

Blocking shapes in  Create basic outlines for the backdrop. Keep in mind that the main 

focus is on the character. However, the world a character lives in is what makes the scene 

believable, as it provides a sense context and location for the events being depicted. Loosely block in 

basic shapes and colours for the snowy mountains, skyline and foreground. Keep the colours and shapes 

interesting, forcing the eye into the distance and conveying a sense of grand scale. You will use these 

shapes as guides for detailing and texturing by integrating photographic assets.

“The world a character lives in 
is what makes the scene 
believable, as it provides a 
sense of context”

Cinematic composition
padding space around main elements to allow for cropping. It’s useful to set up your layers in 

groups, keeping characters, environmental elements, adjustment layers and the backdrop separated, to 

easily readjust if needed. For this tutorial, we will be using a cinematic widescreen, double fold-out format 

at 300 dpi – a size big enough for posters and magazine inserts.

Managing CG layers  Import all character 

CG layers into your composition, stacking the 

layers in the necessary order. Start with the colour pass 

and proceed with two copies of occlusion, one normal 

occlusion layer and set its blend mode to Multiply. Repeat 

the same step for the second copy and set the blend 

achieve the desired look.
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Tell the story with clothing  The 

same principles used for believable skin 

rendering also apply to clothes – remember that 

we are telling a story through a single image, 

so we want to convey as much narrative detail 

as possible. A viking warrior wears hand-made 

animal leather clothes – a compromise between 

warmth and tactical practicality during battle. 

Add details of blood stains, dirt and wear and 

tear, to enhance the look of the fabric. Small rips 

and holes in the cape or trousers will serve as a 

reminder of past battles.

Creating believable skin 

Rendering believable skin is tedious, but it 

makes a huge difference. Custom texture maps 

are generally created for the 3D model, however, 

you will want to add more detail to the renders 

by including elements like bruises, scars and 

imperfections to make the character realistic. 

Place battle scars or wounds on the character 

in areas not protected by the armour, this will 

help create a visual narrative. Paint in extra pores 

and veins in certain areas, and don’t be afraid to 

experiment with bouncing lights and translucency 

to simulate sub-surface scattering or wet surfaces.

Add atmospheric elements Everything 

looks more epic with fog and mist. There are plenty 

of ways to create great particle effects. For this key art, 

our team used the particle engine in Arnold to create thin 

layers of dynamic rolling smoke, combined with hand 

painted thicker layers in the foreground. Place the smoke 

layers at the top of your layer stack and set their blend 

modes to Screen. You will want to keep the opacity quite 

low. With a large soft brush erase the areas further away 

from light sources.

Create the environment  At this stage, break away from your character and focus on the 

environment that he lives in. Start by choosing a colour palette that makes sense, with the tone 

and mood setting the scene that you are depicting. Fill in the areas that you outlined previously with 

Build heavy metal  A viking helm is one of 

the most iconic battle props. Its unique shape 

and curled horns are immediately recognisable, and 

convey a sense of strength. The eye will naturally be 

drawn to the helm, so make this the main focal point of 

your piece. Work with the Dodge and Burn tools to create 

the roughness of a hammered metal sheet. Apply heavy 

scratches by combining brush strokes with photographic 

assets. Follow the shape of the helm, keeping in mind your 

light sources and how light bounces off curved surfaces.

When working with complex lighting, constant 

Fine-tune lighting
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 Our brain processes imagery 

based on colour, shapes and depth. So push the depth of 

your image as far as possible in order to make it pop. Duplicate 

your character group and merge its content – keep the original 

group disabled as a backup. Using the Blur tool, begin softening 

the contours. Use a small brush with low strength. Next increase 

the strength and blur the areas further away, while keeping the rest 

sharp. This will direct the viewer’s eye to the focal points, simulating 

Magic particles  This is a fantasy game, so your character will, of course, have 

supernatural abilities. Use a particle system as secondary focal point to counter-

balance elements and guide the viewer’s eye across the piece. Use warm colours to contrast 

the cool tints of the environment. Start with an orange tint and begin outlining your magical 

interesting. Integrate a soft layer of smoke and an Overlay orange glow layer to add realism 

and make the colours really pop.

Pushing it further  Use three separate 

planes of interest to further increase the depth 

sharp and bright, the midground elements softly 

blurred and mildly lit, and elements in the far distance 

heavily blurred and dark. The reduced readability of 

far away elements, such as the faraway mountain 

tops or rock formations, will serve as hinted reading 

values – the viewer’s brain will complete the missing 

away with minimal colour variation while obtaining a 

very rich and full effect. 

Add drama (sky and clouds) 

A dark sky will set the mood and drive the eye 

into the distance. You will want to create clouds that 

form interesting shapes, low enough on the horizon 

to create enough contrast to allow for easily readable 

mountain tops. Use a large soft brush to paint 

black on top of areas to simulate rarefaction of the 

atmosphere and the light bouncing off. Ensure the 

clouds and foreground fog don’t clash.

Balancing  Create a new group containing adjustment layers for Gamma Curves, Brightness/

Contrast, and Colour Balance, and place them at the top of your composite. These will serve as master 

colour correction settings. Adjust the Gamma Curves until the image looks properly lit. Gamma Curves are 

also helpful to remove possible artifacts resulting from Screen layers and compositing. Use Brightness/

Contrast to bring out highlights, and use the Colour Balance settings to increase Cyan and Blue on both 

highlights and mid tones, as this will help blend elements seamlessly and unify tints.

10

13

14
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Dark areas can 

show artefacts. 

To eliminate 

noticeable 

colour-

banding, apply 

a 0.8 Uniform 

Noise to the 

Screen layer

Layer extra textures on 

the horns to convey a 

sense of an ancient and 

mythological animal

Pay attention to 

rolling surfaces or 

sharp edges, and 

add extra 

highlights or rim 

lights to increase 

realism
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Alternating Shaders  Just like colours 

and tints, materials and shaders work best 

together when they create visual rhythm. Pay special 

attention to creating interesting, alternating patterns 

of smooth and rough textures. For example, a glossy 

metal bolt will look more interesting if placed over a 

rough leather patch. Next add rust and scratches to 

the chest metal plate. Then using a 1pt brush, paint 

fuzzy areas around the edges of the abdominal band 

fabric, sampling the proper shades. This will create 

a more realistic material and convey a sense of wear 

and tear.

 Create 

a new layer at the top of your character group 

and set its blend mode to Overlay. Using a soft brush, 

paint white hot spots over the areas that receive 

specular light – this will help to brighten those areas. 

Pay special attention to edges and corners directly 

more light. For extra realism, consider integrating 

appropriately sizing them, adjusting their tints, and 

setting them in Screen mode over the area of interest.

Sharpening details Using the Sharpen 

strokes over the character’s beard, eyes and lips. 

Proceed gently, making sure that the sharpening 

process does not damage the image or cause 

any pixelation. The main goal here is to increase 

immediate readability in emotionally relevant areas. 

Repeat the same process on portions of the skin or 

steel plates that you want to guide the viewer to.

Using Soft Gradients  Create a 

new layer and place it at the top of your 

background group. Using a large soft circular brush, 

start painting black over the far bottom edges of the 

environment. Try following the curves of the rock 

formations to naturally cast shadows. Using soft 

gradients will add an extra level of dimensionality to 

your backdrop, simulating natural light and shadow 

casting. Set the layer to Overlay and adjust the 

Opacity accordingly. Repeat the same process on 

the lower portion of the character.

Fire embers  Create a layer on top of 

your composition and using a 2pt brush, 

paint light orange dots. Double click on the layer 

to access its properties and select the Outer Glow 

option. Then choose a red tint and adjust the 

Radius and Choke. Now using the Smudge tool 

with a 5pt brush, apply strokes on one side of the 

ember particle pulling away from it. This will create 

a trail or path, giving a sense of motion. Repeat this 

layers to simulate distance from the camera.

Final touches  

due to the natural ink absorption process on paper, there is a 10% Luminosity drop from screen to print. So if 

Gamma Curves.

When working on high-resolution 
images for print, you will be constantly 
zooming in and out of your canvas and 
will want to watch out for artefacts, 
pixelation and aliasing. Press Cmd/
Ctrl+Opt/Alt+0 to toggle back to the 
images actual pixel size and ensure 
your artwork is crisp.

Zoom in & out
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In this tutorial you will learn how to create a 

 You will also learn the techniques of 

photomanipulation and the importance of values to make 

your image pop out and look like it’s from a movie. We will 

go through some digital painting for the character’s hair, so 

make sure to use a pen tablet instead of the mouse as this 

futuristic suit for our model using parts of superbikes as 

our stock, which is a technique that many well known 

artists use for mech design. We will also add a touch of 

abstraction to our photomanipulation by blending 

geometrical shapes and make key post-production edits 

using adjustment layers, Lens Correction and Smart 
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L  scene using Photoshop’s blend modes

When designing something you always need to have an idea 
or sketch; don’t come up with something on the spot unless 

Study

Add drama with 
blend modes

 
 

Artist

self-taught freelance 
concept artist and 

Meknes, Morocco with 

in digital art.

Photoshop

Source Files

Software

On FileSilo

that have been made for 
this tutorial.

si
www.artstation.
com/artist/

  First of all we need to set up our model 

into our canvas, so let’s grab the model image from Dreamstime, 

code: 22992223, then by selecting the Pen tool (P), click and drag on the 

edges of the model, then Cmd/right-click, select Make Selection, and 

the model into our new canvas.

 

Curves and making the Curves an S shape. Don’t drag the points deeper as that will 

(not the layer) set to Overlay. Turn down the opacity and start brushing dark parts of the 

model. Doing this will give you more control instead of doing a regular Brightness and 

01

02

Set up your stock
Place and enhance the basic building blocks of the image
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03 Add smoke effects We said earlier that composition is important 

and the bokeh should not cover the entire scene because we still need 

to add more elements. Next, we’ll add smoke effects to add more texture to the 

background, so grab some smoke textures, and repeat Step 3, but this time 

change the blend mode to Color Dodge instead of Linear Dodge (Add), that way 

the smoke will not ruin the bokeh shapes and it will show clearly on the empty 

areas that we left earlier. Now we need to blend the model with the background; 

this is really simple, we just place a smoke texture layer in front of the model layer, 

place it as shown in the image and turn the blend mode to Linear Dodge (Add).

04

Sketch the futuristic suit 
before we start designing our suit, we need to have a clear idea about what we will be designing. 

So create a new layer and, using a pen tablet and a Round brush around 40px, start sketching the shapes 

on the model that we want to the suit to look like. Here we followed the anatomy of the human body, so that 

the suit will look functional and practical, and will not hold our girl down. You can still do this step if you don’t 

have a tablet by holding the Shift key and pointing with the mouse to create a straight line.

05

Create the suit The sketch is done, and 

right now it’s time to make the actual suit. 

Superbike parts are the best stock to create a futuristic 

suits or robots or anything from the future thanks to their 

already cut out. On this part you can be as creative 

as you can but keep in mind that the suit needs to be 

practical. Our model’s hand is in the foreground, so 

we need to create a mask so that the suit will appear to 

be behind the hand. To do that, we will select the Pen 

tool and repeat Step 1. When the selection is on, select 

the bike part that will be behind the hand and click the 

Mask button below on the Layers palette, then you can 

duplicate the mask by holding Shift and dragging the 

mask to another layer.

06

Create the background Now it’s time to create our background, 

so grab some bokeh textures from CGtextures.com, place them behind 

the model layer and change their blend mode to Linear Dodge (Add). Also you 

can create a new layer, change the blend mode to Screen, and with a Soft Round 

brush, add some light around the model to make her pop out. Keep in mind that 

composition is really important, and our bokeh textures should not cover some 

parts of the canvas because we will place other elements and textures there later. 

Our background is composed of three bokeh textures so we need to blend them 

into one texture, to do that create a layer mask and with a Soft Round brush, hide 

parts of the textures that are not needed.

“Since our 
background is 
bright and is 
our light 
source, our 
model should 
be dark 
because the 
light can’t 
reach her, only 
bounce light is 
able to 
illuminate her”
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Add shadows 
07

08

Modify hair09

Adjusting values 10

Rain effects 

deviantart.com

Enhance and adjust
Tweak colours and image elements to get the required effect

For a successful change of 

colour, your original hair should 

always be light; if dark, the 

Overlay fi lter will not work

The SSS effect in hair gives 

more realism, but use it only 

according to your light source

Adding a touch of 

digital painting to 

photomanipulations 

is always a plus
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11

More effects Now add some more effects on the 

suit. This step is pretty easy, so let’s create a new layer, 

grab a small Hard brush with light blue and change the blend 

mode to Linear Dodge (Add), and draw some lines as shown. 

Then click on the FX button next to the Mask button and select 

12

Abstract shapes Add surrealism to a piece to 

make it more artistic and eye-catching, instead of just 

creating a scene from a movie. So make a new layer and with 

the Polygonal Lasso tool, create triangular shapes around the 

model. When creating a shape, it will automatically be selected. 

With a soft brush, press Alt to select a colour with the Eye 

Dropper and paint the triangle. Repeat this process until you get 

an effect that works with the composition.

13

Create the energy shield 
then select the Polygon tool, set the sides to three, choose a blue colour for the Fill, and no 

14

Light effects It’s time to add light effects. It’s important to add some abstract lighting 

effects to your scene to give it more life, so grab the cosmic lights PNG pack textures from 

psdbox.com

and change the Hue Slider to make it blue, then change the blend mode to Screen. Next, we will add 

psdbox.com

and place it on the brightest spot of the background and change the blend mode to Screen and turn 

For a piece of artwork to be truly great, it is important 
that you are telling the viewer a story. Artwork with a 
story is always far better than an emotionless piece 
of work.

Visual help
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In order to do great photomanipulations, 
you need to have a great photo library. 
Here are some great sites to gather the 
best stock photos and resources: 
deviantart.com, cgtextures.com, psdbox.
com, mediamilitia.com. It is a great thing 
to have good photomanipulation skills 
because it’s not only used to create 
illustration for books or music, but it is a 
great tool to use in concept art for the 

realistic as possible.

Master 
photomanip-
ulation

Final effects Make sure all your elements are in place and everything is set out properly, then right-18

Place the energy shield 
done, it’s time to apply it to our canvas, so select all the 

play with the sliders until you get a darker blue, then change the 

15

16

17 Colour correction 

Story elements 
photomanipulation is nearly done, 

Here we added tears, and smoke coming out 

we will use smoke brushes and watercolour 

a black colour and apply it on the eyes as 

select a smoke brush, choose a white colour 
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Landscapes
Create huge fantasy worlds

134 Render a fairytale castle

142 Construct a landscape from photos

148 Paint a digital landscape

154 Imagine epic fantasy landscapes 

158 Work with matte painting

164 Master pro painting techniques 

168 Create a landscape with brushes

168

158

134

142
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For this image I was inspired by 

Romantic-style architecture, 

such as Neuschwanstein Castle 

in Germany, to create a towering 

building nestled on the side of a 

mountain, surrounded by forests and 

steep hills. Over the course of this tutorial, 

I will explain how exactly I went about both 

making the castle itself, and then how I 

created the surrounding landscape. 

Starting with Blender’s ANT landscape 

plug-in, we’ll create some procedural 

mountainous terrain, then block out the 

basic forms of the castle with Blender’s 

modelling tools. Next, we’ll jump over to 

ngPlant, a free app that lets you create 

procedural plants. Last of all, we’ll 

head back to Blender to create 

a procedurally generated forest 

around the castle before 

we eventually texture 

and render the 

scene.

Render a 
fairytale castle
An image of a towering castle perched on the side of 
a mountain, inspired by medieval architecture

134  Fantasy Art Genius Guide

Landscapes
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Ben Simonds
www.ben 
simonds.com

Artist

Ben Simonds is a 3D 
Artist at Gecko 
Animation Ltd, a small 
London-based studio

Photoshop, ngPlant
Software

Concept
Before starting, I searched online for some inspiration 
and sketched a few rough thumbnails of castles to 
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Blender’s Dynamic Topology tool is fantastic for 
sculpting forms quickly when you don’t quite 

can grab and stretch your mesh in all sorts of 
ways without worrying about topology, or add as 
much detail as you like without subdividing 

collapse details into rougher topology if you use 

Dynamic Topology 
sculpting

Choose a site With the terrain in place, start looking for somewhere to situate 

the castle. To do so, use Blender’s Fly Navigation (Shift+F in the 3D Viewport) to 

need a small peak next to some larger mountains to place the castle on, so that it’ll have 

the taller terrain as an impressive backdrop. With the site chosen, simply place down a 

cube to mark the castle’s site for the time being, then placed a camera roughly where we 

Generate terrain Our castle will need some mountains in 

which to exist, so let’s begin by using Blender’s ANT Landscape 

provides all sorts of settings for tweaking the kind of terrain generated. 

Next, turn up the number of subdivisions and increase the mesh size, then 

play around with the other settings to get something you’re happy with.

 

feature enables you to sculpt and have your mesh dynamically tessellated under your brush strokes. 

03

01 02

“We need a small peak next 
to some larger mountains, so 
that it’ll have the taller terrain 
as an impressive backdrop. 
Simply place down a cube to 
mark the castle’s site for the 
time being, then placed a 
camera roughly where we want 
the fi nal render”
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Block in with Primitives To start off the castle, 

use very rough shapes just to plan what parts the castle 

will have. Add and scale cubes and cylinders for the towers 

and use cubes with the top face pulled upwards to make a 

peak for the main buildings. Play around with a few different 

like, while moving them around to see how they look from the 

Break up the castle To make working on the castle easier, break up its design into 

chunks, with one for the front wall and gatehouse, another two for the two main buildings, 

and another for the foundations and the bridge. Duplicate these chunks and place them on 

group, while working on them separately. Additionally this lets us work on the different groups in a 

Get an early render Maybe it’s good planning or maybe it’s just time wasting and 

the shadows falling on the castle.

Detail the architecture Using the blocked-in 

geometry of the different chunks of the castle as a 

guide, begin creating more detailed models of the castle. For 

each large section of a building or wall, begin by creating a 

about including secondary elements, such as windows, doors, 

crenellations along the walls and other architectural details.

04

06 07

05
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Work with duplicates While the overall structure of the castle 

is pretty unique from piece to piece, there are a lot of repeating 

elements in the design of the castle overall. Especially for the windows, we 

only need to create a few different designs, which we then duplicate and 

place around the castle. By using linked duplicates, we can keep every 

instance of each window type sharing the same mesh data. Not only does 

window), but it also helps enormously when UV unwrapping and texturing 

the castle, as objects that share mesh data similarly share texture space, 

and only need unwrapping once per design.

UV Unwrapping Unwrapping models is always a pretty tedious task, but Blender has 

some pretty useful unwrapping tools. For each chunk of the castle, we should try to pack 

easy – just use the basic Unwrap Operator, or sometimes the Project From View Operator for large, 

(the Select Co-planar Operator is great for this – press Shift+G in Edit mode with a face selected), 

then pin those vertices’ UV coordinates, add seams to the model and then unwrap the surrounding 

areas to get a passable unwrap for the more complex areas. As soon as the task of unwrapping 

the models is done, we can move onto other, more creative aspects!

Add crenellations and towers Most of the walls and roofs of the castle 

are embellished with crenellations. To create these, model a single section of 

the forms of the walls and roofs – going round corners and curves and leaving gaps for 

towers and windows. For the round towers, use the Warp Operator in Edit mode to wrap 

the linear design around a cylindrical form. By snapping the 3D cursor to the centre of the 

tower and placing the un-deformed crenellations at the correct radius from the centre, 

the Warp Operator takes the X-axis of the geometry and wraps it around a circle.

Add trees with ngPlant ngPlant (www.ngplant.

sourceforge.net) is an open-source plant-modelling 

application that lets you create plants by starting with a trunk 

mesh, to which you can add branches upon branches until you 

want to add leaves on the end. To make our trees, start with 

a relatively tall trunk, then add a few levels of branches. In my 

experience, tweaking the controls for the Branch Density, Axis 

Variation and Declination (the angle that branches point up or 

down based on how far up the parent branch they are) has the 

that have repeating elements. It comes with several 
different inputs for specifying how you want to duplicate 
geometry. The Relative Offset setting is best for duplicating 

settings to automatically merge vertices between repeats. 

as it lets you use the transforms of an Empty to specify the 
offset for repeats. This lets you rotate and even scale the 
repeated elements. I used the object offset as an alternative 

wanted around the tower.

Array

08

09

11

10
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“While the overall structure of the castle 
is pretty unique from piece to piece, 
there are a lot of repeating elements in 
the design of the castle overall. 
Especially for the windows, we only 
need to create a few different designs, 
which we then duplicate and place 
around the castle”
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Export the trees The other great feature of 

ngPlant is that you can easily create variations on a 

single tree design. The parameters for tree creation feature 

several random factors, such as Axis Variation (bending along 

the length of branches) and the Rotation Angle between 

different branches, the results of which are governed by a Seed 

property (found under the General settings for the tree). By 

cycling through Seeds, you can achieve a wide range of 

different trees with the same overall features, but that are subtly 

different. Let’s export a few of these variations (with some 

later import into Blender.

Create a forest To make a forest out of trees, use a particles system. Add a new 

particle system to our landscape with several-thousands of particles, all emitted on the 

Group, and set the Trees group as the source. This populates the landscape with thousands of 

trees. Add some randomness to them with the Size set to Random, and by randomising their 

Rotation slightly. We can also use the Particle Info material node to convert the individual particle 

trees indices into a slightly randomised green hue for the needles’ Diffuse colour. This will give 

every tree a slightly different appearance and will make the forest look less homogenous.

Bake textures for the castle Returning to the castle, we have already unwrapped 

each chunk to a texture sheet, so switch render engine to Blender Internal temporarily 

(Cycles has only started supporting texture baking in the latest dev builds, so I stuck with BI) and 

bake out a few maps. For each chunk of the castle, bake an Ambient Occlusion map, as well as a 

few different seamless brick and concrete textures. As well as this, bake out a Groups map for each 

chunk of the castle, assigning different colours to areas we want to paint with different materials. 

This makes selecting different areas easier for texture painting and masking textures.

Set materials for the trees The materials for our trees are pretty simple to 

accomplish, and entirely procedural. NgPlant does a good job of automatically generating 

UVs for your generated trees and exporting them with separate material groups for each branch 

or leaf level. For all the branches, simply apply a brown Diffuse material. For the needles, take 

the UV co-ordinates of the long leaf meshes that run along each of the branches and manipulate 

them with nodes to give a gradient out from the middle of the branches to the edge, and use 

this as the overall Alpha of the material (by controlling the Mix Factor between a Diffuse and a 

Transparent Shader node). Multiply this Alpha factor with a procedural Wave texture that breaks the 

close scrutiny, in a forest of thousands it looks the part.

An alternative to ngPlant is Blender’s Sapling add-on. 
This tool works in a very similar way to ngPlant. It 
also has a number of procedural parameters for 
generating trees, and it has some nice tools for 
affecting the overall shape of a tree (as well as some 
presets for common shapes). It can even 
automatically create a rig for your tree to enable it to 
animate and sway. However, its options for leaves 
are much more limited and there is less control over 
each level of branching, so I stuck with ngPlant for 
my trees.

Use the plug-ins

12

14

15

13



Fantasy Art Genius Guide  141

Genius Guide
Fantasy Art

Combine texture baking and painting In Photoshop, combine the baked 

maps, using the group’s map to mask different areas of the texture with different base 

textures (different kinds of brick or concrete). Next, multiply this with the AO map on a low Opacity 

to add some basic grunge, then paint in some further variation and cloning in grunge from other 

sources. The result for each part of the castle should be a nicely aged texture with a consistent 

brick pattern that doesn’t look too repetitive overall.

Render passes
the scene into a few different passes, with one 

for the foreground of the scene (including the castle 

itself), another for the background landscape and a third 

for the background trees as a separate layer. It’s also 

worth rendering out some clouds and a simple Z-Depth 

pass that we can use to add some aerial perspective to 

the scene.

Texture the landscape For the landscape, take a 

slightly matte-painted approach, creating the landscape 

texture from the camera perspective to save time. Grab images 

of mountains, grassy hills, and rocky cliffs from texture websites, 

and use different bits of each to cover the landscape, blending 

them together by adjusting their colours manually and cloning 

parts together. Create two separate textures for the foreground 

and background of the landscape. You don’t need to worry too 

much about large areas of texture looking entirely plausible, as 

most of the landscape is going to be dominated by the forest in 

any case.

 Using 

Layer in the different render passes and combine 

them with gradients, a slight vignette and some colour 

Try painting in the odd wisp of cloud or erasing the 

occasional stray tree by hand. You could also add a 

slight bloom effect by creating a merged copy of the 

layers, blurring it and tweaking its Levels before adding it 

back onto the scene to create softer lighting in the scene.

We want to add clouds to 
the sky, which can be done 
using Blender’s Cloud 
Generator plug-in, as well 
as some painting thrown in 

image. In a separate scene 

which we linked our 
landscape objects and 
camera), loosely model 
streaky clouds, then 
convert them to clouds 
with the Cloud Generator 
tool. This add-on turns a 
mesh into a cloud object 

material for rendering in 
Blender Internal. Render 
the clouds as a separate 
pass that we can eventually 

image. For my image, it 
didn’t look amazing as just 
a basic render pass, so I 
did a fair bit of messing 
about with it in Photoshop 
later on.

Create 
clouds

16

17

18

19
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Learn how to use Photoshop to 

create a fantasy scene with this 

tutorial. We’ll start with creating a sketch. 

Try to experiment with different ideas and 

choose the most interesting option. It’s important 

to think through all the details before you start 

work. We will combine fragments of photos to 

create a background and unique objects to 

create a fantasy environment. Creating scenes 

isn’t easy when you’re working with different 

source photos. You will need to use colour 

correction elements and effects so that the 

image becomes attractive and convincing. You 

will also learn how to manually create sunlight 

and shadows, as well as achieve uniformity 

across all elements.

In order to successfully complete this tutorial 

you’ll need a base knowledge of Photoshop. We 

will be using different tools, such as selection 

tools, layer masks and adjustment layers, colour 

corrections (Curves, Color Balance, Selective 

Color and more) and brushes. Use a pen tablet 

if possible – using a mouse will make the 

has been completed with Photoshop CS6, but 

you can use most other versions. 

Fantasy Art Genius Guide  143

Construct a 
landscape 
from photos
Learn how to work with fragments of photos to create 
a fantasy scene

Nadegda 
Mihailova
www.nm-art.weebly.
com/tw

Artist

Nadegda Mihailova is a 
digital artist and creative 
retoucher from Russia, 
specialising in 
environment illustrations. 
Milhailova is currently 
working as a freelance 
digital artist. 

Photoshop

Source Files

Software

all the images needed to 
complete this tutorial.

Preparing the background
Use multiple images to create a background

Create the sketch  
document: File>New, set document size to 2,950x4,200px. 

Then create a sketch. At this stage it is important to make a 

decision on composition and the location of all objects in the 

scene. Think through all the details before you start work; you will 

need to decide on the overall colour of the image and light sources.

Make the 
background 

Open the image 

‘IMG_02-1.jpg’ and 

cut the mountains 

with a Lasso tool, and 

then move them onto 

your scene and scale 

accordingly. Duplicate 

this layer and modify 

the shape, remove 

borders around it with 

soft Eraser tool, and 

merge into the scene. 

Then select Image> 

Adjustments>Curves, 

lower the contrast and 

add more blues and 

lower the saturation using 

Hue/Saturation. Note 

that the further away the 

object is, the less details 

you should see.

01 02
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Use adjustment layers as clipping masks for editing 
elements. This means you will have the opportunity 
to go back and edit part of your image – you can 
weaken or strengthen the impact if necessary.

Edit with layers

Add the sky Use images IMG_03-1.jpg - IMG_03-5.

jpg to create the sky. Cut out sky fragments and add them 

to your scene. Then select Edit>Transform>Warp and change 

their shapes as needed. Now make the sky more consistent by 

selecting Curves and adjust the brightness, contrast, and colour 

for each element. Use the Eraser tool with soft edges and Clone 

Stamp tool to eliminate seams. Merge these layers and slightly 

darken the upper portion of the image.

Form the tower Create the tower shape out of stone textures by cutting stone texture 

fragments from images IMG_05-1to IMG_05-4.jpg. Use Transform and Warp to change their 

shapes and sizes. Make brightness and colour consistent among all the fragments. Now draw a 

spiral on top of the tower. Merge these layers and “heal” the seams with Clone Stamp tool. Select 

the Brush tool with soft edges, change the blending mode from Normal to Multiply, set Opacity to 

10-25% and darken the bottom and left parts of the tower. Add the riverbank from IMG_05-1.jpg to 

the right side, then select Hue/Saturation and reduce saturation and lightness.

Add details Cut out elements from IMG_06-1.

jpg (1) and place balconies around the tower. Make 

the left and right sides darker and the central part of the 

balcony lighter. Then repeat to create the second balcony. 

Place the window from IMG_06-2.jpg (2) in the center of the 

tower. To add smaller windows use IMG_06-3.jpg (3), adjust 

Color Balance and Curves to make the windows’ colour and 

brightness consistent with the stone texture. Make the window 

sides’ upper and lower parts darker. Decorate the tower 

facade with elements from IMG_06-4.jpg (4). Reduce the 

brightness by adding reds and yellows using Color Balance.

The landscape Insert the mountains from IMG_04-1, IMG_04-2 and IMG_04-3.

jpg to your scene. Add more blues using Color Balance and lower the contrast. Create 

a new layer then draw some fog in the right of your scene using a light-blue Brush tool with 

soft edges, on 10% Opacity. Paint the mountain edges and peaks with the same brush. This 

should add more consistency to the entire scene. Add the forest (IMG_04-5.jpg), the bridge 

(IMG_04-4.jpg), and the grass (IMG_04-6.JPG) in front of the mountains. Adjust brightness, 

contrast, and colour for each element by using Curves, Color Balance, and Hue/Saturation for 

the desired result.

03

05

06

04
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09

08

Top of the tower Create a new layer and draw 

ridges (1). Take a colour sample from the stones. 

Place the pattern from IMG_07-1.jpg under the ridges (2). 

Then select Transform>Warp to change the shape as 

needed. Adjust brightness, saturation and colour for all 

added elements. Add shadows on the left and under the 

ridges using a brown soft brush in Multiply mode with 10-

20% Opacity. Copy the small windows from the previous 

step and place them on the tower (3) then add decorative 

stone elements (IMG_06-4.jpg) to the tower facade.

Add more 
volume 

Select the layers that 

relate to the tower and 

merge them. To add 

more volume, create a 

new layer, change this 

layer’s blending mode 

to Multiply and set 

Opacity to 30-

40%. Use clipping 

masks, so that you 

can apply effects 

to only this object. 

Right-click on the layer 

and select Create 

Clipping Mask. Use 

a soft brown brush to 

darken the bottom and 

left parts of the tower 

as well as areas under 

the spiral. Increase 

shadows on the 

windows and brighten 

the central part of the 

tower using a Curves 

adjustment layer.

Bottom of the tower Use elements from IMG_08-1.jpg to create columns and add them to 

the facade. Select Image> Adjustments>Hue/Saturation to decrease saturation and lightness. 

Use IMG_08-3.JPG to create the gates and place them under the layer with columns. Use Curves 

to decrease the brightness then add yellows and reds. Copy the balcony and place it between the 

columns, reduce its brightness. Place the stone elements (IMG_08-2.jpg, IMG_06-4.jpg) and windows 

(IMG_08-4.jpg) on the tower. Add the bridge (IMG_08-5.jpg) and draw stairs on the right side of the 

bridge. Adjust brightness, contrast, and colour for these new elements.

Adding more elements
Create the tower and other elements from fragments of photos



146  Fantasy Art Genius Guide

Landscapes

Create small 
towers Create small 

towers in a similar way. Copy 

the stone texture from the main 

tower and change its shape 

as needed using Warp and 

Transform. Draw the spiral and 

tower peaks. Then add building 

fragments from IMG_10-1.

jpg, reduce brightness, and 

add yellows and reds using 

Curves. Insert the tower top, 

IMG_10-1.jpg then adjust 

colour. As in step 09, adjust 

light and shadows for more 

visible volume. Merge the 

layers related to the small tower, 

duplicate the layer and place 

it above the left balcony. Make 

it darker and erase the bottom 

part. Use images IMG_10-3.

JPG, IMG_10-4.jpg to create 

the remaining small towers.

Add Plants  Add plants IMG_11-4.JPG, IMG_11-5.

JPG behind the tower then reduce brightness, contrast, 

and saturation. Place the plants from IMG_11-1.jpg, IMG_11-2.jpg, 

IMG_11-3.jpg on the tower surface, adjust their brightness and 

colour balance. Create a new layer, change its blending mode to 

Soft Light and set Opacity to 30-50%. Create a clipping mask on 

the layer with plants. Go over the plant edges with brown soft brush. 

Then create a new layer under the plants, set blending mode to 

Multiply and Opacity to 20-30%. Paint shadows under the plants. 

Build the rock Copy the gates from the main tower and paste them 

onto the rock and reduce contrast. Now cut out part of the stone texture to 

create the bridge. Use Warp Transform to change the shape as needed – erase any 

unnecessary areas. Then make the right and bottom parts of the bridge darker. Add 

columns from IMG_13-3.jpg (1), reduce their brightness, add reds and yellows using 

Color Balance and make the bottom part darker. Insert windows from IMG_13-1.

jpg (2) into the rock. Use IMG_13-2.jpg (3) to create the top of the building. Adjust the 

brightness and colour of these elements to make them consistent with the rock. 

Lights on the tower 

Change the layer blending mode to Screen. Transform the layer by scaling it down and 

way. To enhance the glow create new layer, set blending mode to Overlay, Opacity to 50-70% 

“Do not forget to adjust brightness and colour 
for all the elements you add”

10
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14

17 18

15

16Waterfall and river Use IMG_14-1.jpg 

to create the riverbank under the rock (1). 

Reduce brightness and add blues using Curves. Cut 

out water texture and paste it in the river. Select Hue/

Saturation to decrease saturation of yellows then 

add blues using Color Balance. Add the waterfall 

from IMG_14-2.jpg (2) and adjust its brightness and 

colour. Now use IMG_14-3.jpg and IMG_14-3.jpg 

(3) to form the lower part of the riverbank. Change 

the rocks’ shape as needed using Warp. Use Hue/

Saturation to reduce saturation of reds and yellows. 

Highlights Create a Brightness/Contrast 

adjustment layer, set Brightness +60 and 

Contrast +20. Invert the layer mask using Cmd/

Ctrl+I and paint darker areas inside it with a soft 

the tower, tower tops, bridge, waterfall, landscape 

on the right, and to the foreground. You can lower 

the adjustment layer Opacity to 80-90% to make 

it weaker. Add a new layer with blending mode 

set to Soft Light and Opacity to 50-70%. Select a 

a brush.

 To add more depth to the image, 

reduce the contrast of the background. Create a new layer 

and using a light blue soft round brush, Opacity 10%, paint over 

the background and behind the tower several times. This will add 

more depth and separate the tower from the background. Now 

you will need to add more consistency to all the elements. Try to 

experiment with adjustment layers for Solid Color, Gradient Fill, 

Gradient Map and various blending modes and Opacity. I selected 

a blue Solid Color and set blending mode to Soft Light and Opacity 

to 15-30%. Then select Gradient Fill, set colour to orange and 

set blending mode to Overlay in order   to enhance the sunlight 

 Place the 

rocks from IMG_15-1.jpg in the foreground. 

Create the lower part of the rocks from the fragments 

of IMG_15-2.JPG and use the Clone Stamp tool 

to remove seams then merge these layers. Draw 

the entrance in the upper part and extend the 

bridge so it reaches the gates. Then duplicate the 

bridge to create the second one, place it to the right 

and reduce the brightness. Add the ladder from 

IMG_15-3.JPG and add plants on the right side of the 

riverbank with IMG_11-3.JPG. Do not forget to adjust 

brightness and colour for all the elements you add. 

They should be consistent with other the elements in 

the scene. 

 Now add more 

volume and depth as well as focus the 

viewer’s attention on the tower. First, add more 

shadows. Remember that the light source is coming 

from the top right. Create a new layer and change its 

blending mode from Normal to Multiply; set Opacity 

to 50-70%. Use a dark coloured brush, not black, 

and add more shadows to the left side of the tower, 

lower part of the riverbank, the areas behind the 

tower and to some of the foreground. Add shadows 

to the small elements and plants. 

Final editing
 foreground and the fi nishing touches

Use layer groups to optimise your work.  When you have too many layers, working with them can become 

Optimise by using layer groups

When you draw the small 
details, it is important that they 
do not stand out among 
photorealistic elements. To 
disguise them create a new 

set the blending mode to 
Overlay. Create a clipping 
mask then go to Filter> 
Noise>Add Noise, and set 
Amount between 1-7%. Go to 
Filter>Blur>Gaussian Blur 
and set radius to 1-2 pixels. Or 
place a suitable texture 
instead of noise, reduce 
saturation, set the layer mode 
to Overlay or Soft Light then 
adjust Opacity. 

Hide the 
drawn 
elements 
with noise
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Traditional paintings are exciting. 

They evoke energy, texture, dedication 

and passion. Through this tutorial, you’ll 

learn how to paint an exciting fantasy illustration 

using only Photoshop, a graphics tablet and 

some imagination. No paint mess, turpentine 

spillage or sitting around waiting for your canvas 

to dry, just textured strokes and well-thought-out, 

bold colour choices that make people go “ooh”.   

Using reference correctly is one of the keys to 

becoming a successful artist, and something 

we’ll cover in this tutorial. Through studying the 

fundamentals, in particular composition, 

anatomy and colour theory, you can expand 

your visual libraries and improve the ideas you 

put down on paper. In order to prepare for a 

study them. Treat them as a resource to 

examine whenever you get stuck or need to 

reference directly. Before you begin, grab some 

images of paintings you like and look at how the 

emulate here.

148  Fantasy Art Genius Guide

Paint a digital 
landscape
Create a fantastical digital illustration using 
traditional painting techniques

Landscapes



Fantasy Art Genius Guide  149

Genius Guide
Fantasy Art

Fantasy Art Genius Guide  149

Paul Scott 
Canavan
 www.paulscott 
canavan.com

Artist

Canavan is the art 
director at Scottish indie 
game studio Blazing 

illustrator when he gets a 
spare minute. 

Photoshop

Software

Genius Guide
Fantasy Art



150  Fantasy Art Genius Guide

Landscapes

Collect reference pictures
Base your work off of the world around you

Collecting references Start by collecting references. 

These can be photographs relating to aspects of the image, 

for example skies, landscapes and waterfalls, or paintings that 

match the mood you want to create. Because we’re going for a 

traditional look here, you could include work by painters such as 

John Singer Sargent, Thomas Cole and modern artists like Jaime 

Jones. Create a new document in Photoshop and simply drag 

refer to later.

Create an underpainting In traditional painting, artists sometimes create 

an underpainting as a base for subsequent layers of paint. This technique applies 

nicely to digital painting; if you allow breathing room between your strokes, you’ll get some 

of that colour and texture showing through. Create a new document at A3 size. Choose a 

colour that contrasts with your palette; in this case we used blue tones. Grab your favourite 

want those imperfections.

01

02

03 Sketch! 
Having spent 

some time absorbing 

your reference images 

and scribbling in a 

notebook, you should 

have a good idea of 

what you want to draw. 

Create a new layer 

above the underpainting 

and get scribbling. Think 

about the composition; 

you want to lead the 

viewer’s eyes through 

the painting. The best 

way to do this is to use 

lines that lead directly 

to the focal point, in this 

case the mountain, and 

to use colour and value 

contrast to pop it out. 

Don’t worry about being 

clean and careful, as 

you’ll be deleting this 
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04

06 07

05
Start painting Focus on big shapes

“Take your time and really think about each stroke you are applying”

Don’t zoom in!Light and rendering
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Use your 
references 

To create realistic, 

tangible forms in your 

environment, you can 

reference photographs 

directly. To do this, open 

created in step 1 and 

place the image beside 

your canvas. Treat 

sections of your painting 

as mini studies to help 

as the rocks. Try to learn 

while you work; pay close 

attention to the way light 

and shadows fall over the 

stone, but bear in mind 

that this might be different 

to the palette and lighting 

you are painting!

Composition tips
indicate the rule of thirds, a commonly used composition breakdown in which you place 

items of interest on the lines and in particular where they intersect. You can see in this image that 

the focal point sits on an intersection and a line, while the character sits dead centre in the lower 

horizontal. The red lines indicate how the rock shapes are intended to drive your eyes through 

the painting.

In Photoshop, 
Layer Masks allow 
you to control 
transparency simply 
by painting in black 
and white. They’re 
great for adding 
texture, blending 
layers or making 
adjustments that 
don’t affect the 
whole image. Instead 
of using the Eraser, 
just go to Layer> 
Layer Mask>From 
Transparency and 
experiment to what 
suits you… you won’t 
go back!

Learn 
masks

Adding detail
painting blocked in nicely, it’s time to focus on individual 

areas. Bring your attention over to any part of the image you 

think is lacking and start to render it out. Remember, you aren’t 

going for incredible detail here, more the illusion of detail; 

you want to save areas of highest detail for your focal points. 

Change your brushes frequently to add varied texture to the 

painting and don’t be afraid to be bold with your strokes. 

Cloud rendering To paint the clouds, use a hard 

square brush to lay in the forms in combination with 

the Smudge tool to soften and stretch the undersides. The 

mixture of hard and soft edges lends believability and weight 

to the shapes even though they’re still quite abstract. The 

Smudge tool can be used for painting rocks and other forms 

too – experiment with different brushes in conjunction with it! 

John Silva has some fantastic smudge tool presets available at 

johnsilva.deviantart.com.

08

09

10

11
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It’s important to rest your mind every hour 
or so, both to maintain energy levels and 
to return to the image with fresh eyes. 
Often you’ll notice glaring errors when you 
take even a short break, which you might 
have missed otherwise. 

Remember
to take regular 
breaks

Check your values

Character painting

Finishing touches

Atmosphere12

14

13

15
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Landscapes

Learn how to use a 3D block mesh, 

photo bashing and digital painting 

techniques to create an epic fantasy 

kingdom scene. The combination of Maya and 

the renderer Chaos Group V-Ray will help you to 

set up the perspective and basic lighting for the 

use digital painting techniques to match, 

merge and change the photos to the way 

you want them, which will help you to create a 

This is an advanced Photoshop tutorial, for 

artists who have a bit more experience with this 

program or someone who wants to push their 

Imagine epic 
fantasy worlds
Combine photo elements and painting techniques to create photoreal concept art

Landscapes
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for the tutorial, from the 
base image to all the 
added photos.
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If you want to select a part of a 
reference image you picked for 
the painting, use the Quick 
Selection tool to create a fast and 
accurate selection. Sometimes 
the Quick Selection tool creates 
better results than Color Range 
selection or the Magic Wand tool.

Use quick 
selection

Extend the photos The next stage is 

the extension of photo elements by copying 

the images and painting on top of them. Duplicate 

the sky image with Cmd/Ctrl+J and put it under the 

original sky. Than use the Move tool to move it to the 

right. Make another copy and move it down. After 

that, merge the sky layers together and use the Brush 

tool with a chalk brush to paint a seamless edge 

between all the sky parts. 

Match the elements Now it’s time to 

match the mountain with the sky. Hit Cmd/

Ctrl+B for Color Balance to match the colours. Select 

Shadows and add a bit of cyan to the mountain. 

Press OK and open the Hue/Saturation dialog with 

Cmd/Ctrl+U. Go to the cyan and blue channel and 

pull down the Saturation. Create a new layer behind 

the mountain layer. Use the Lasso tool to make a 

shape for the distant mountains. Pick a shadow 

this colour.

First Photobash The next step is the 

background. For a better overview, create a 

group by clicking the group icon in the Layers panel. 

To browse the photos you want to use in the image, 

the best way is to use Adobe Bridge or Adobe Mini 

Bridge. To activate the Mini Bridge, go to File>Browse 

background, double-click on the thumbnail in Mini 

Bridge to open them. Use the Move tool to move the 

3D Block Sketch Create a new document 

with a size of 5661 x 3669 pixels and 300dpi. You 

will start by using a 3D render. The 3D render was created 

with Autodesk Maya and V-Ray. You can use other 3D 

programs and renderers to create a similar image, like 

CINEMA 4D or Google SketchUp. The 3D mesh will 

help to give you the basic composition, perspective and 

lighting for the scene. For this painting, the 3D part was 

completed in around two to three hours. Render out 

different passes like Diffuse or RGB.

“The 3D mesh will help 
to give you the basic 
composition, 
perspective and 
lighting for the scene”

The middle background 
mountain Now you can repeat the same 

techniques as used in the steps before. Try to match 

the shape of the 3D render to the scene as much 

as possible, as well as the lighting direction. Create 

a new group and call it something like ‘midground 

mountain’. Import the images into your Photoshop 

create a layer mask for every image you want to add 

and paint the shapes. Here, tree images were used 

to create a base for the mountain.

Overpaint the waterfalls

Now you need to match the waterfall size by 

painting on top of the waterfall. Create a new layer 

on top of the waterfall layer and use a chalk brush. 

Pick a dark colour from a nearby area and just 

paint some lines on the waterfall. Then add some 

smaller islands and stones. Go to Image>Image 

Rotate>Flip Horizontal to have a fresh eye and check 

the perspective and scale. Create a new layer and 

set it to Lighten. Pick the sun colour and paint some 

highlights over the waterfall where the light hits.

Add the waterfalls Other than the 

sun rays, the background needs another 

interesting element – the waterfalls. To create 

these, use two different waterfall images. To paint 

the shapes of the waterfalls, create a layer mask by 

clicking on the layer mask icon in the Layers panel 

and paint with the round brush in black to change 

the shape. It’s important to look at the size of the 

trees – the waterfalls shouldn’t be bigger than 

the trees on the mountain. After that, match the 

colours again with Color Balance.

Overpaint the mountain The 

next step is another overpaint and colour 

matching. You need to match the grassy top and 

the forest to the rocky mountain image. To match 

the colours, use the Match Color adjustment. Go to 

Image>Adjustments>Match Color. Select the PSD 

layer. After you have done this, create a new layer 

for the overpaint and paint the edges between the 

images, as well as painting in some trees on the light 

side of the mountain.

01

03

04

0706

05

08

02
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When you work with 3D, be sure to render 
out as many passes as possible, including 
Diffuse, Ambient Occlusion, and shadow 
and light passes. You can then combine 
these passes with the layer blending 
methods in Photoshop, like Multiply, 
Darken and Lighten.

Render out 
passes

Paint the snowy distant 
mountains Flip the image again to get a 

fresh eye. Create a new group. Use the 3D part as a 

base, but extend the shape a bit more with the Lasso 

tool. Import a snowy mountain and put it into the 

Midground mountain Create another 

the mountain. Import some more grassy mountain 

image and paint some areas away if it ever starts to 

Paint the sun and sky Create a new 

sunny side of the mountain.

Final details of the mountain Here, 

Create a new layer on top of the latest layers you 

09

12

14

10

Cloud cover 

of the mountain group and one behind. Paint in some 

three images for the water and two for the riverside in 

Main cathedral, gate and 
riverside

paint on top of it. Do the same with the bridge and 

the wall. For these elements, just use some old stone 

Copy the image from the riverside on the left and put 

it between the tree images you added before. For 

the tree, use just one image and paint on top of every 

Final step
add some textures to 

the remaining parts. Create a 

some randomness. Then 

paint all the sunny parts 

moody feeling. Press Cmd/

4%. Change the layer mode to 

Lighten at 75%. Done.

13

15

11



Learn how to create a realistic matte painting using 
layer and clipping masks

Work with 
matte painting

Telling a story with a single image can 

be a challenge, but this tutorial will 

show you how to do just that. You will 

learn how to create a photorealistic digital matte 

poster, on a website or any other media that uses 

images that are not primarily moving.

Light & Magic, and since then its photomanipulation 

procedure in VFX studios around the world. This 

tutorial will show you how to combine all these 

techniques together, using the Brush tool, clipping 

and layer masks to overcome any problems you 

exploration and sketching, using elements to tell a 

story, combining and merging photos seamlessly 

and many more. Photoshop allows you to use 

building an image like this, have a look at some 

existing images that could provide inspiration.
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some of Rudolph’s 
photos to help complete 
this tutorial.
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Inspiration and basic idea  

First direction  

Integration  

The path 
01

03

04

02

“To match the colours, use a 
combination of Color Balance, 
Levels and Hue/Saturation 
adjustment layers”
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More clouds for the sky To create a focal 

point in this area, you have to add more clouds. 

Here, cirrus uncinus clouds have been used, which have a 

very neutral and clear formation. To extract the clouds from 

the previous sky, use the Color Range selection tool, which 

and paint in it with a soft brush. To match the colours, use 

the technique from the previous steps.

the sketch 
Once you’re happy 

with the result, insert 

the mountains to add 

a sense of depth to the 

image. Now it’s time 

and add storytelling 

elements to it, like 

mountains, which 

are moving towards 

the sun. The brush 

strokes should now 

be more accurate 

with higher Opacity. 

Use the pre-existing 

values and colours 

from the image to add 

the sketch. The brush 

used here was the 

Chalk brush again. 

painting the mask and matching the 

colours, it’s time to add some sky on the right-

hand side. This step should be very easy and 

straightforward: just use your current sky and 

move it to the right. Then create a new layer mask 

again and paint on it with a 250px soft brush to 

create a smooth edge. Don’t use the Gradient 

tool because the result will look too vague.

 All 

the next steps will be 

done using the current image 

as a base. You don’t want to 

get into detailing the image 

too quickly, so create a new 

and use a Chalk brush with 

Pen Pressure on for the 

very roughly on the image 

to create smooth brush 

strokes. The result doesn’t 

have to look perfect. It’s only 

important to create realistic 

the rest of the landscape.

 The next step is 

to replace the sky. Rudolph used his own 

photos to do this. Again, it is important again to 

choose a sky with a similar light direction as the 

To create a good-looking edge, use a layer mask 

on the mountain layer and put the sky behind. 

Then start painting on the mask. 

05 06 07

When you want to 
match the colours and 
values of different 
photos, it’s best to 
create two major 
adjustment layers: one 
Hue/ Saturation with 
Saturation at 89% for 
matching colours, and 
one Hue/Saturation at 
-100% to match the 
values. Put these on 
top of all your layers.

Match
colours

08

09
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 Start with the big rocky 

element on the left side. Use the sketch for the basic shape 

 After 

images with the same sense and form of the trees 

 There 

 The small rocks help to sell 

select the sketch layer 

key and clicking on the 

rock image and add it to 

10

13 14

12

11

15

Copy

Before you start, 

fi nd inspiration 

from fi lms, 

music, photos or 

books. This will 

help you to create 

a unique idea

Colour match 

different images 

together using 

Color Balance, 

Hue/Saturation 

and Levels 

adjustment layers

Don’t go directly to a 

fi nal image. Use 

simple shapes and a 

rough idea to create a 

clear view to your goal

The composition of an image is 

the magic behind it. Control the 

eyes of the viewer and lead 

them through the image
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 “To create some more 
highlights, add a new 
layer and paint on top 
of it with a soft brush”

 Now it’s time to 

start working on the rocks. All details 

added should be on separate layers as 

clipping masks. For these rocks, use images 

of cliff walls in Thailand or Vietnam. Use 

the sketch shapes as a base and add the 

details on top of them. To create some more 

highlights, add a new layer and paint on top 

of it with a soft brush, with the layer set to 

Overlay blending mode. 

 Now 

it’s time to add more interesting 

the background mountain to make the 

foreground mountain look a bit bigger. 

create a sense of movement. Last but 

not least, break up the horizon with a 

big rock in the foreground. For all new 

changes, create new layers, and change 

the shapes with a layer mask.

This step has a 

massive update. But to create 

this, you just have to use the 

same techniques you used 

before. The sunlight helps to 

explain the story behind the 

image. Add some smaller, 

smoky clouds to the rocks in 

the foreground. This helps to 

add a bit more motion to the 

image. Use as much as you 

can from the elements you 

already have in the image, 

as you can see on the rocks 

coming out of the ground.

 The 

added rocks will now be 

the right shape and colour, 

but they don’t feel like a 

part of the image. Create 

a new layer and put this on 

top of the rock layer, then 

create a clipping mask with 

Cmd/Ctrl+Shift+G and 

paint with a black coloured 

soft brush on top of it. Do 

the same with the rock on 

the left-hand side. For the 

details on the bottom of 

the rocks, paint with a new 

layer on top of the rock 

layers using the Clone 

Stamp tool.

 
feeling. Then add some dirt and very small rocks to the rocks to suggest that they are coming directly from the earth. The very 

Noise, set to 400% and Uniform. Set the layer to Overlay mode and set the Opacity to 5-10%.
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Learn how to paint a futuristic, eco-friendly cityscape 
using Photoshop’s brushes and tools 

Master pro painting 
techniques 

Anticipation, literature and painting 

have for centuries been the main 

source of creative inspiration when 

thinking about the future. In our times, this is a 

genre of illustration that has become a dominant 

form of expression thanks to the burgeoning 

cinematography industries. However, it’s usual to 

industry projects time and again, so the 

continuous search for original points of view is a 

must in this kind of work.

Photoshop is clearly the best tool choice. It is 

the ideal application to simulate traditional 

painting techniques, which get improved through 

the program’s powerful colour correction, 

allows you to work at lightning speed compared 

to some traditional mediums. Photoshop is also a 

great environment to work with your visual 

references and elaborate your ideas from them. 

However, keep in mind that there is no digital 

replacement for artistic research and planning, 

which will always be the foundation of good 

design work, independent of your medium. 

In this tutorial, you will learn how to plan and 

paint your own futuristic vision in Photoshop, from 

of a fully detailed painting, working extensively 

with brushes, layering and adjustment tools.

Andres Avaray
www.avaray.com

Artist

Andres Avaray is a 
digital artist who has 
worked mainly in the 
videogames industry, 
animation, short 

He especially 
enjoys conceptualising 
mad and unique 
fantasy ideas.

Photoshop
Software

Landscapes
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Reference for imagination I store a 

personal archive of thousands of real world 

pictures gathered over the years. They are about 

history, architecture, nature, art and real people. It 

is important to store in both the unconscious mind 

and hard drives whatever boosts your imagination, 

and revisit it when researching a new artwork. Adobe 

Bridge is a nice tool for browsing references.

Thumbnail ideas Sketch ideas 

after you become inspired. Work on a 

parcelled-out canvas like this and play with the 

details. It is a time to enjoy, so that is why you 

shouldn’t be too worried about what brush tool you 

okay at this stage. 

Plan the composition Time for a 

strong composition. You can learn about this 

from Andrew Loomis books and articles about the 

golden ratio and rule of thirds. Use a low-detail tool 

like a wide Conte brush, working out the element 

placement and overall feeling. Working in black-

depths. Overlay guide layers to check that the 

composition and perspective is really working.

Plan your painting
From reference to painting the base layer

01 02
03

Sketch and light a new view Use 

a simple brush and draw on a new layer on 

top of the stack. It is time to combine all the previous 

planning in a sketch that will serve as the foundation 

for the work ahead. Avoid too much perfectionism, 

On a lower layer, place a suitable base colour that 

matches the atmosphere. Over this one, place a new 

layer in Overlay mode and paint using shades of grey 

04
Set up the colour palette A quick way 

to create a colour palette for this kind of work is 

to choose a few textures that, when blended over the 

desaturated value layer, provide some basic tones 

and grainy detail. The sketch base colour was a deep 

blue, so the chosen textures are blue with some 

details in a contrasting colour: orange or red. Masks, 

blending modes, and Levels and Curves adjustment 

layers (Layer>New Adjustment Layer) are powerful 

palette that serves well at all picture depths.

05
Collapse 

the base colour, value, textures and 

adjustment layers into a single one – the base layer. 

Place your sketch layer over this one to serve as a 

painting reference from now on. Prepare a soft 

The Eyedropper tool is an ally at this step, because 

now we proceed with picking up tones and painting 

Curves or Levels adjustment layers in order to 

06

This is a long range picture, with a lot of 

overlapping elements placed from near to far away. 

In this kind of work it’s crucial to keep a correct 

sense of depth as it’s easy to lose it in the painting 

process. As a preparatory step, create a group of 

masking layers. Every layer matches a group of 

elements at a certain depth. You can do the same 

by saving pixel selections, Select>Save selection, 

but this way is a more visual and immediate one.

07 Apply depth
Checking depth is very easy in 
black-and-white images. Place a Hue/
Saturation adjustment layer over all 
your work. Set the Saturation slider to 
-100. Make this layer visible every time 
you need to check that the depth and 
perspective are working.

Genius Guide
Fantasy Art
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MASTER PRO PAINTING TECHNIQUES 

Create depth with adjustment layers Traditional methods for creating depth require you to 

individually stroke colours, varying saturation, hue and value until the correct depth is achieved. A far quicker 

way is to use our recently created masking layers in combination with new Hue/Saturation and Levels adjustment 

layers. This way you will obtain the colours that provide the correct depth. Do not hesitate to stroke rough details, 

Detail vegetation (2) Another way of 

painting vegetation is to pick colours from our 

previous work and paint using a foliage picture-based 

brush. Again, avoid a stamped look by using the 

Smudge tool later. This method is suitable for grass 

and bushes, and also for trees placed far away. It is 

important when painting vegetation to use a varied 

palette of green, yellow and grey. Also, remember 

that colours tend to desaturate and get bluish with the 

distance. Study and use some vegetation references in 

order to make it look natural.

Detail vegetation (1) Use a picture-based 

brush to place some trunks and branches. Then, 

lock transparent pixels in the Layers palette. Paint with 

the same brush in Overlay mode to add extra shading 

details. On an upper layer, create the foliage with a 

picture-based leaf brush. Use masked adjustment 

layers to create quick light and shadow gradients. Picture 

is better to avoid; distort the stamped strokes with the 

Smudge tool. Use this method for nearby and more 

detailed vegetation. 

Check before detailing 
Now the painting should be working 

However, this result is the foundation for 

the following detail steps to work. Feel 

free to re-paint or add any elements that 

may improve and boost your painting’s 

composition, value, depth and design. 

Use contrasting colours to guide the eye 

through the composition. In this case, 

warm orange and yellow colours are 

placed strategically so the eye is guided to 

the central building in the painting.

Begin the real paint work 

base layer. This will make the painting start to come alive.

The painting process in depth 
From base layer to a fi nished painting

08

09

10

11 12

“Use contrasting colours 
to guide the eye through 
the composition”

Paint layers from 

far to near. The 

parts of the 

painting that are 

furthest away 

should be at the 

bottom of the 

stack. This helps 

control 

overlapping 

strokes

Work fi rst on the medium and 

dark tones in your painting. 

Highlight strokes should be the 

last ones that you use, lighter 

colours will act as a guide

Do not get too obsessed with any 

particular detail. Change among 

painting elements from time to 

time to keep a global view
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Detail using texture brushes This painting depicts a world of 

constant recycling, where everything is re-used. That is why the painting 

should look as organic as possible in its details and at close range. To achieve 

that stroked texture effect, work on details using organic picture-based brushes. 

Use Size and Angle Jitters, Window>Brushes>Brush Tip Shape>Shape 

Dynamics, so the brushes make organic and random marks. You can create 

13

Make the paint bloom
Add fi ne details, textures and adjustments

Make your world human Contextualising this new world is as 

painting. Humanising your world will also provide a sense of scale that will turn the 

artwork into a more accessible one. Because this is a low energy world, vehicles 

should be manufactured from recycled old ones and electric-powered. Also, 

some people will have to use animal power for work and transportation.

 Small details add a 

lot of eye-catching value to a painting but 

avoiding excessive detail that will get lost. Use this 

kind of detail to better explain the world. Windows, 

signs, urban art, lights or landmarks are all good 

possibilities. This is a world of constant recycling; 

that implies maintenance is done using different 

reused materials. Mix crystal with wood, or stone and 

concrete architecture in the same buildings. 

14

15 Texture the image Do not place textures 

using different blending modes. Overlay and Color 

modes will be the most frequently used followed 

by Color Burn, Hard Light, Lighten and Multiply. 

Different modes mix textures in different ways: 

choose wisely. Opacities should be lower than 50-

60% in order to avoid textures catching the eye too 

much and altering the previous colour work. 

16

Finish the sky The sky often works as 

negative space for an illustration. Also, it is 

possible to create interesting lighting and depth 

effects with it. First, create a painted mask similar to 

the ones from step 7. Select some sky photographs 

and place them over the paint to make the sky more 

interesting. Use masking and adjustment layers for 

smooth details from the texture combination.

17

Final adjustments 
Again, the quality of the 

brute texture overlays and global 

adjustments, but should be slightly 

adjustment layers and edit the Red/

Green/Blue channels. Avoid making 

some parts of the picture too dark 

or burned. Layer masks are able to 

affect different parts of the image in 

different ways, simulating subtle light 

effects. A blurred texture with a similar 

colour palette placed over the work at 

colour detail. 

18
Shading
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Photoshop CC comes complete with a great 

selection of brushes, from traditional paint 

bristles to charcoal and airbrushes, but there’s 

nothing quite like creating your own unique set to 

give your work that personal touch. In the past you 

would do this using Photoshop’s built-in brush editor, but 

with the recent release of the Adobe Brush app for iOS 

devices, it’s now possible to take photographs on the go 

with your iPhone or iPad and upload them instantly onto 

the cloud to use at home. Real paint marks, scribbles on 

paper, toy cars, that pile of socks which never seems to 

around the house and pull them straight into Photoshop to 

play around with.

In this tutorial you will learn how to create brushes using 

Adobe Brush, import them into Photoshop CC and paint 

an epic, colourful landscape from scratch. The only things 

you require are an iOS device, Photoshop CC, an internet 

connection and some imagination. It’s going to be a fun 

one so grab a cup of tea and let’s get started!
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Paint an epic landscape using your own custom brushes, 
captured through the CC app, Adobe Brush

Make some marks  Adobe Brush allows you to 

create brushes out of anything, so it’s worth spending 

this image, let’s keep it simple. Grab some nice pens and 

pencils and make some marks on paper. Don’t worry about 

being neat – you can tweak these marks later.

01

Import your doodles 
Open the Adobe Brush app 

and click the plus button. Choose 

Camera and take a photo of one of 

your brush marks. You’ll notice that 

you can now see your brush at the 

top of the screen – this is a preview 

window and will allow you to get a 

feel for how it’ll look when drawn in 

02

You can really go to town on 
the sort of textures you 
import using Adobe Brush. 
Don’t be constrained by 
pencils and pens. Try 
photographing a ball of 
scrunched-up paper, your 
cat’s hair, a dinosaur toy or a 
strip of tree bark.  

Texture 
your art

Create a 
landscape 
with brushes

Start with a scribble
Make and capture your brushes in Adobe Brush

 
 

Paul is the art director at 
Scottish indie game 

and a freelance illustrator. 
He likes dinosaurs and 
weightlifting.

Photoshop

Source Files

Software

On 

that have been made for 
this tutorial.

Artist
Paul Scott 
Canavan
www.paulscott 
canavan.com
@abigbat
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03

Play with settings Now this is the fun part. 

how the brush acts when drawn in Photoshop. Keep an 

eye on the preview window, and play with the pressure 

and spacing settings. For a good starting brush, set the 

Pressure to Flow, the Spacing to 15% and the Scatter 

to 30%. You can also add some jitter to the stroke to 

make it even more random, but make sure you keep it 

immediately save your new brush to the Cloud.  

04

Import your brush Open Photoshop CC. Open the Window tab and select Libraries. You will 

now see a new tab on-screen which links directly to your CC Library – any brushes you have created 

and saved in the Adobe Brush app will be available here. To get started, select your new friend in the library 

window and it’ll be selected as your current brush. Open a new Photoshop document (Cmd/Ctrl+N), give 

it a scribble and see what it looks like in practice.

05

Edit and save Now that your brush is 

selected, you can edit it further in Photoshop. 

Click on Window again and open the Brush panel. From 

here, you can edit any aspect of the brush, from how 

heavily it applies to the canvas to how scattered the 

strokes are. Go through each section and mess with the 

sliders and buttons, regularly testing it out by scribbling 

on the canvas. Once you are happy, click the ‘Create 

New Brush’ button at the bottom right of the panel and 

it’ll be added to your library!

06

This screen allows you to clean up the photograph that you have taken. 

background that you don’t want. Ideally, the brush should sit happily on a transparent background, but you 

You can use your newly 
created brushes for 
more than just drawing 
or painting. The Eraser, 
Smudge and Dodge/
Burn tools can all be 
pulled from the Cloud 
Library too! Experiment 
with different brushes 
to give your smudges a 
rougher edge or your 
dodges a little more 
randomization.

Other 
uses
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Brush examples Here are some examples of the 

brushes that I created for this tutorial. You’ll notice that by 

tweaking the settings in the brush panel, you can end up with 

extremely varied results. In fact, three of the brushes used here 

have come from the same scribble. Every time you save a new 

brush it’ll be added to the Brush Presets panel, accessible 

through the Window tab. You can leave this open while you work to 

quickly change brushes, or alternatively Cmd/Ctrl+right-click on 

the canvas.

07

08

The sky Once you have your entire 

individual sections. The sky is often the most 

important part of your painting, as it sets the mood 

and colour for the entire piece, as well as the light 

source. Study some cloud photographs and paint in 

some rough cloud shapes using a big brush. Treat 

clouds as chunky 3D shapes and let them interact 

with the environment, passing behind and in front of 

the mountains.

10

Sketch your image  Choose a brush that works nicely at a smaller size and 

create a new layer for the sketch. You can use reference for this, it’ll help you to 

understand how the real world works and add another level of realism to your painting. Try to 

create a dynamic composition – something that leads the viewer’s eyes into the image and 

holds them there. Look at some master painters and see how they construct their images 

for inspiration! Every time you study a master painting you will learn something new about 

composition or colour application.

Use your brushes in Photoshop
Grab your brushes and start painting

Start painting With the line art complete, set the layer to Multiply. This allows the dark lines to show 

over any paint beneath them. You can lock this by clicking the padlock icon, so you don’t accidentally 

draw on this layer. Create a new layer below the line art and paint using a large brush. Focus on the overall 

shapes and colours – don’t worry about details. It’s helpful to zoom your canvas out to around 16.7%.

09

For a successful 

change of colour, your 

original hair should 

always be light; if 

dark, the Overlay 

fi lter will not work

The SSS effect in hair 

gives more realism, but 

use it only according to 

your light source

Adding a touch of 

digital  painting to 

photomanipulations 

is always a plus
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11

Continue working around the canvas, 

very organic process, so work on a single area until you get 

foreground is typically a selling point as it can lead the viewer 

12

you would a rock or a character – the upper sections are hit 

13

14
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As mentioned in Step 16, the Quick Mask tool is 
generally more useful than the Eraser, and is very 
simple to use once you get the hang of it. Erasing 
is permanent, whereas masks allow you to paint 
details in or out at any time, and generally give you 
more control. 

To use a mask, click the ‘Add Layer Mask’ button in 
the layer panel. This creates a small white image of 
your canvas next to the layer name. When this is 
selected you can only paint in black or white – 
painting in black acts as an Eraser, painting in white 
brings information back.

The magic of masks

Finishing touches 18

Run with it 
15

16

17 Take a break 
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How Photoshop 
Creative can help!
Inspirational techniques
Each issue is packed with tutorials showing you how 
to do everything in Photoshop

Loads of FileSilo resources
Enjoy superb downloadable content every month

Join the community
Become part of the Photoshop Creative community 
to with competitions, galleries and more

About 
the 
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Or telephone UK 0844 848 8402+ overseas 01795 592 880
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YOUR FREE RESOURCES
Log in to filesilo.co.uk/bks-872 and download your free resources NOW!

YOUR BONUS 
RESOURCES
ON FILESILO WITH THIS 
BOOKAZINE, FREE AND EXCLUSIVE 
FOR FANTASY ART GENIUS GUIDE 
READERS, YOU’LL FIND A WEALTH 
OF INCREDIBLE RESOURCES 
AVAILABLE, INCLUDING…

spectacular fantasy landscapes from the 
experts at Digital-Tutors

fantasy characters

All the tutorial  
resources

Bokeh effect brushes

Spray and drip brushes

PACKED WITH BRILLIANT 
DIGITAL CONTENT, AVAILABLE 
ANY TIME, ON DEMAND

EVERYTHING 
YOU NEED 

TO FOLLOW 
ALONG WITH THE
BOOKAZINE AND

CREATE GREAT
FANTASY ART

COMPLETE THE TUTORIALS WITHIN
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FILESILO – THE HOME OF PRO RESOURCES

A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

Discover your free online assets

The most popular downloads are shown 
in the carousel here, so check out what 
your fellow readers are enjoying.

Find out more about our online stores, 
and useful FAQs, such as our cookie and 
privacy policies and contact details. 

If you’re looking for a particular type of 
content, like software or video tutorials, 
use the filters here to refine your search.

Whether it’s tutorial files or video 
workshops, categories make it east to 
identify the content you’re looking for.

See key details for each resource 
including number of views and 
downloads, and the community rating.

Discover our fantastic sister magazines 
and the wealth of content and 
information that they provide. 

The first time you use FileSilo, you’ll need 
to register. After that, you can use your 
email address and password to log in. 

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link 
on the following page.
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HOW TO USE
EVERYTHING YOU NEED TO KNOW ABOUT 
ACCESSING YOUR NEW DIGITAL REPOSITORY 

Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the 
best use of your free resources? Want to have your work critiqued by those in the know? Then 
why not visit the Photoshop Creative and Imagine Bookazines Facebook pages for all your 
questions, concerns and qualms? There is a friendly and active community of fellow image-
editing enthusiasts waiting to help you out, as well as regular posts and updates from the team 
behind Photoshop Creative magazine. Like us today and start chatting, sharing your work, and 
getting involved with one of the brightest fantasy art communities on the web!

NEED HELP WITH
THE TUTORIALS?

To access FileSilo, please visit filesilo.co.uk/bks-872/

01 Follow the on-screen 
instructions to create 

an account with our secure 
FileSilo system, log in and 
unlock the bookazine by 
answering a simple question 

about it. You can 
then access the 
content for free 
at any time, and 
download it to 
your desktop.

02 Once you have 
logged in, you are 

free to explore the wealth of 
content available on FileSilo, 
from great video tutorials 
and exclusive online guides 
to superb downloadable 
resources. And the more 
bookazines you purchase, 
the more your instantly 
accessible collection of 
digital content will grow.

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device using 
any popular browser (such 
as Safari, Firefox or Google 
Chrome). However, we 
recommend that you use a 
desktop to download 
content, as you may not be 
able to download files to 
your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.

facebook.com/ImagineBookazines
facebook.com/PhotoshopCreative
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